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CAEPIPE 

Mod File 

1.0 Introduction 

KP2CII: KP2CII Translator program is a stand-alone program, which shall be used for transferring pipe 

geometry, section properties and other engineering properties from CAEPIPE to CAESAR-II. 

The sequence of this Translator operation is shown diagrammatically in Figure 1-1. 

 
 
 
 
 
 
 
 
 

 
 
 

 
 

 

 
 

Figure 1-1 

 

This manual describes the development done on KP2CII Translator. It is assumed that the user is already 
familiar with CAEPIPE and CAESAR II. 

1.1 How the Translator works? 

1.1.1 The pipe(s) modeled in CAEPIPE are saved as mod file by CAEPIPE. 

1.1.2 The Windows compatible executable KP2CII.exe reads this mod file and maps it against the 

material and hanger mapping mdb to identify the valid CAESAR II material name and hanger 
name that correspond to the specified CAEPIPE material name and hanger specification. 
This executable finally generates the batch input file (*.cii), which can t h e n  be 
imported into CAESAR II to create binary model file (*._A) that can be opened and viewed 
in CAESAR II. During the conversion of Analysis model from CAEPIPE, the program 
simulates certain elements to have an identical mathematical model in CAESAR II.  The 
details of such simulations are described under the section “Reference”. 

Note:   Refer Appendix A for more details on modifying the Material and Hanger mapping database. 

CAESAR-II 
Batch Input File 

(.cii) 

CAESAR-II 

KP2CII Translator 
Mapping 

DB 
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2.0 Installing the Program 

Refer Section 1.0 in SST License Manager User’s Manual for details. 

3.0 Limitations of Translator 

The present version of the CAEPIPE-to-CAESAR II has the following limitations. 

Presently the following CAEPIPE inputs are not transferred to CAESAR II input format. 

1. Additional weight of Valves 

2. Flange placed at disconnected end 

3. Flange placed at “Bend” Node 

4. Hinge Direction 

5. Force Spectrum Load 

6. Harmonic Load 

7. Wind Load 

8. Jacket end cap 

9. Negative gap used in Limit Stops 

10. Beam Element 

11. Due to the limitation in the CAESAR II batch input file, the Analysis Option from CAEPIPE is not 
transferred to CAESAR II. The User has to set the same manually in CAESAR II 

12. Pumps, Compressors and Turbines 

13. Spectra, Spectrum levels, Force spectrum and Time history 

14. Pressure (P10) and Thermal load (T10) 

15. Generic Support details 

16. Piping system with node numbers greater than 32000 as CAESAR II has limitations in node 

numbers (i.e., max node number = 32000) 

Transfers of certain “element” types and “data” types from CAEPIPE input into CAESAR II input format 
takes place as follows 

 

Sl. No CAEPIPE Input Being transferred to CAESAR II as 
1. Valves Rigid Element 

2. Flange Rigid Element with 0.1mm length 

3. Concentrated Mass Rigid Element with 0.1mm length 

4. Hinge Expansion Joint with zero length 

5. Bellows Expansion Joint 

6. Ball Joint Expansion Joint 

7. Elastic Element Expansion Joint 

8. Cut Pipe Cold Spring 

9. Tie Rod Rigid Element 

10. Limit Stops Equivalent Restraints 

11. Rod Hangers Restraints (+Y or +Z) 

12. Threaded Joints SIF or TEES 

13. User SIF SIF or TEES 

14. Branch SIF SIF or TEES 
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4.0 Working Procedure 

 

4.1 Selection of CAEPIPE mod file can be done in two ways viz. by entering the name of the 

CAEPIPE mod file along with the valid path in the text box provided or by clicking the button 

available near the text box opens a file dialog and lets the user to navigate and select the 

CAEPIPE mod file. 

4.2 Similarly, enter the name of the CAESAR II batch file to be created as explained in Step 4.1. 

4.3 User can specify the Default Material and Hanger to be used in CAESAR II during the transfer 

through “Option->Set Default CII Material and Hanger”. 

4.4 Program checks for the availability of Material and Hanger in CAESAR II corresponding to 

CAEPIPE and replaces them with the default Material and Hanger specified by the user upon 

unavailability. 

4.5 Design option for CAESAR II Hanger can be specified through “Option->Design Option for CII 

Hanger”. 

4.6 Click  the  button  “Transfer”  to  transfer  model  from  CAEPIPE  to  CAESAR  II  format.  Upon 
successful transfer, user gets the message box as shown below. 

 

 

4.7 Launch CAESAR II software and from the “Tools” menu select “External Interfaces->CAESAR II 

Neutral File”. 

4.8 Select the radio button “Convert Neutral File to CAESAR II Input File” and then press the button 
“Browse”. 

4.9 Navigate and select the “.cii” file thus created and press the button “open”. Upon successful 
import user will receive the message “The conversion was completed successfully”. 
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5.0 Reference 

This section describes in detail, the methodology followed for transferring the Elements and Data types 
from CAEPIPE to CAESAR II. 

5.1 Element Types 

Pipe 

Pipe from CAEPIPE is transferred as PIPE to CAESAR II. Translator uses the same node numbers used in 

CAEPIPE while transferring to CAESAR II. The section, material properties and load corresponding to the 

pipe element read from the CAEPIPE are assigned directly to the section property, material property and 

load fields (Auxiliary fields) of CAESAR II. 

Bend 

In CAEPIPE, the term Bend refers to all elbows and bends (custom-bent pipes). Some of the items 

associated with the bend are shown in figure below. 

 

 

Node 20 is the Bend node, which is at the Tangent Intersection Point (TIP). As you can see from the 

figure, TIP is not physically located on the bend. Its only purpose is to define the bend. CAEPIPE 

automatically generates the end nodes of the curved portion of the bend (nodes 20A and 20B, called the 

near and far ends of the bend). The data items such as flanges, hangers, forces, etc. can be specified at 
the bend end nodes (20A and 20B in the figure). 

In CAESAR II, the actual bend curvature is always referred from the “To” end (Far end) of the element. 

Hence, to simulate CAEPIPE bends with CAESAR II bends, the Translator performs the following. 

Transfers Bend as Bend to CAESAR II. 

Node number used for defining the Bend in CAEPIPE (TIP) will be transferred as “To” end (Far end) in 

CAESAR II. 

Creates a Near end node in CAESAR II by adding the node number with 10000. 

Locates the Near end node at (Bend_Max_angle – 5 degree) from the Far end. If this location is already 

used for defining the intermediate  bend node,  then Translator tries to locate the Near end  node at 
(Bend_Max_angle – (5 + 5)) and so on. Failure of locating such node point by the Translator will 
be reported in the .log file for user reference and the Data types such as Hanger, Rod hanger, etc., placed 
at this location will not be transferred properly. 

Long radius in CAEPIPE is transferred as long radius in CAESAR II 
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User defined bend radius from CAEPIPE is transferred as Bend radius in CAESAR II with value 

corresponding to the User Bend Radius value in CAEPIPE. Please note the CAESAR II will generate an 
error message if the Radius of the Bend is less than Outer Diameter of the Section. 

Short radius in CAEPIPE is transferred as User defined in CAESAR II with the value equivalent to the OD 

of the preceding pipe. 

At this time, the “Bend Material” defined in the bend input dialog of CAEPIPE is not transferred to 
CAESAR II. The material specified in CAEPIPE “Layout” frame is used for the bend. 

Miter Bend 

Miter Bend from CAEPIPE is transferred as Bend with number of cuts in CAESAR II 

Widely spaced Miter bend from CAEPIPE is transferred as bend with two (2) miter points in CAESAR II. 

Closely spaced Miter bend in CAEPIPE is transferred as bend with three (3) miter points in CAESAR II. 
All other parameters are the same as that of Bend. 

Valve 

Transferred as Rigid Element to CAESAR II. The weight entered in CAEPIPE is the empty weight (without 
contents, insulation, etc.,) and will be transferred to CAESAR II as Rigid Element weight. The additional 
weight entered into CAEPIPE will not be transferred to CAESAR II. By default, for valve elements, the 

Thickness factor and the Insulation Weight factor are always assumed as 10 and 1.75 respectively in 

CAESAR II. Hence, to have the identical results between CAEPIPE and CAESAR II, it is necessary to 

model the valve elements in CAEPIPE with Thickness factor as 10 and Insulation Weight factor as 1.75. 

Reducer 

Transfers Reducer as Reducer to CAESAR II. The OD1 and Thk1 entered in Reducer Input dialog of 
CAEPIPE will be transferred as Diameter and Wall thickness of the current piping element (element on 

which the Reducer is placed). The OD2 and Thk2 entered in Reducer Input dialog of CAEPIPE will be 

transferred to CAESAR II as “To” end Diameter and Thickness of the reducer element, if the “To” end is a 
disconnected end. For continuous piping, the Translator will not transfer the OD2 and Thk2 to CAESAR II. 
CAESAR II, by default, will take the Diameter and Thickness from the following element Diameter and 

Thickness. 

CAEPIPE calculates reducer weight as the weight of a pipe with its OD as the average between OD1 ad 

OD2 and its thickness as the average between Thk1 and Thk2. On the other hand, CAESAR II calculates 

the reducer weight as the weight of a pipe with its OD and thickness as OD1 and Thk1 of the reducer. 
This is contrary to the statement given in CAESAR II Technical Reference Manual, which states that the 

reducer element is assumed as 10 pipe cylinders, each of successively larger (or smaller) diameter and 

thickness over the length for calculating the weight. 

The observation made during the verification and validation of the Translator for reducer element is listed in 

Appendix E for reference on the above subject. Hence, you could see a difference in the Total Weight of 
the piping system between CAEPIPE and CAESAR II depending upon the number of reducers in the 

piping system. 

Bellows 

Transfers Bellows as Expansion Joints to CAESAR II. The Axial Stiffness, Bending Stiffness, Torsional 
Stiffness and Lateral Stiffness entered in CAEPIPE will be transferred as Axial Stiffness, Bending 

Stiffness, Torsional Stiffness and Translational Stiffness respectively. Translator calculates the Effective ID 

from the Pressure thrust area entered in CAEPIPE and then transfers the same to CAESAR II. 
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Slip Joint 

CAESAR II does not have a Slip Joint element. It could be modeled, as two annular packing glands 

separated axially along the joint by a dead air space, or by a small bellows sleeve. Hence, it is difficult to 

generate a mathematical model through the Translator. Refer CAESAR II – Application Guide for 
more details on generating a mathematical model for slip joints. 

At this time, the Translator transfers only the section property and the material property entered at the 
slip joint of CAEPIPE to material property and section property fields (Piping Spread Sheet) of 
CAESAR II. The Friction force, Friction torque, Pressure thrust area and the weight entered in at the 
Slip Joint of CAEPIPE will not be transferred to CAESAR II and will be explicitly reported to the .log file. 

Hinge Joint 

Transfers as Expansion Joint using zero length elements with axial, transverse and torsional stiffness as 

rigid. Transfers the bending stiffness entered at the Hinge joint of CAEPIPE as bending stiffness of 
Expansion Joint in CAESAR II. Hinge direction in CAESAR II cannot be entered directly and is defined 

using restraints and connection nodes. In addition, the restraint line of action should be defined normal to 

the hinge axis. Hence, at this time, the hinge direction defined in CAEPIPE will not be transferred to 

CAESAR II and will be explicitly stated in the .log file for reference. Refer CAESAR II – Application Guide 

for more details on modeling Hinge Joints. 

Ball Joint 

Transfers as Expansion Joint using a zero length element with axial and transverse stiffnesses as rigid 

and essentially zero bending and torsional stiffnesses. 

Rigid Element 

Transfers Rigid Element as Rigid Element to CAESAR II. The rigid element weight in CAESAR II is the 
empty weight and does not include content and insulation weight. CAESAR II internally adds content and 
insulation weight to this empty weight. On the other hand, when the option “Add Content, Insulation and 
Lining weight” is turned OFF in CAEPIPE, then the weight of Rigid Element in CAEPIPE is the total weight 
inclusive of content and insulation. Hence, the Translator will deduct the content weight and insulation 
weight from the CAEPIPE Rigid Element weight and transfer the resulting empty weight to CAESAR II. 

Note: If you do not want the Translator to deduct the content weight and insulation weight from 
Rigid Element, then define an Environmental variable “SubRigidContWt” with value of the variable set as 
“No”. In other words, to match with CAEPIPE Rigid Weight input, Translator will write the Insulation 
Thickness, Insulation Density and Fluid Density values as 0.00 in CAESAR II input file for Rigid 
Elements. This will make CAESAR II not to add content weight and insulation weight during analysis. 

Elastic Element 

Transfers Elastic Element as Expansion Joint to CAESAR II. Transfers the stiffness entered in CAEPIPE 

Elastic Element to CAESAR II Expansion Joint Element as listed below. 

“kx” as Axial Stiffness 

Higher of “ky” and “kz” as Lateral Stiffness 

“kxx” as Torsional Stiffness 

Higher of “kyy” and “kzz” as Bending Stiffness and 

Temperature for the elastic element in CAESAR II will be set as Reference Temperature for temperatures 
T1 through T9. 
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Jacketed Pipe and Bend 

Jacketed Pipe modeling is difficult in CAESAR II. For modeling the Jacketed Pipe in CAESAR II, the user 
has to model the core piping first and then the Jacket Pipe by copying and modifying the core pipe 

information. Hence, it is difficult to fully automate the transfer of Jacketed Pipe from CAEPIPE to 

CAESAR II using the Translator. 

At this time, the Translator transfers the Jacketed Pipe from CAEPIPE to CAESAR II as core piping with 
section and material properties as entered and then Jacketed Piping by copying and modifying the section 
property and the material property of the core piping. The Translator duplicates and assigns the same 
node numbering for both core piping and the Jacketed Piping. User has to manually change the node 
numbers for Jacketed Piping and also has to verify the model for its correctness. 

Cold Spring (Cut Pipe) 

Transfers Cold Spring as Cold Spring to CAESAR II. As stated in the CAESAR II – Applications Guide, 
Translator selects and writes the Material as 18 and 19 to represent the Cut Short and Cut Long Pipe 
respectively from CAEPIPE to CAESAR II. 

Beam 

Since CAESAR II does not have the provision to store the information of Beam Element into batch input 
file (.cii), Translator cannot transfer the Beam Element details from CAEPIPE. 

Tie Rod 

Transfers the Tie Rod as Rigid Element to CAESAR II with weight of the Rigid Element as 0. 

Comment 

Comments from CAEPIPE are ignored during the conversion. 

Hydrotest Load 

Transfers the Hydrotest Load as “Hydro Pressure” to CAESAR II. 

5.2 Data Types 

Anchor 

Transfers Anchor as Restraints to CAESAR II. The following are the algorithm used for transferring the 

Anchor details from CAEPIPE to CAESAR II. 

1. Transfers Rigid Anchor (Rigid in all the six degrees of freedom) as “ANC” restraint to CAESAR II. 

2. Transfers Rigid Anchor with Displacement as “ANC” Restraint to CAESAR II and creates a virtual 
connected node with the available free number (1 to 32000) in CAESAR II  and writes the 

displacements defined for each temperature in CAEPIPE (T1 to T9) to vector 1 through 9 of 
CAESAR II. The displacements defined under the T10, Seismic and Settlement will be ignored 

and NOT written to CAESAR II at this time. User has to add/create the load combination in 

CAESAR II before performing the analysis. This is explicitly reported in the .log file. 

3. Transfers flexible anchors as six flexible restraints to CAESAR II (X, Y, Z, RX, RY and RZ). The 

stiffnesses defined in CAEPIPE in the six degree of freedom are written to each restraint type in 

CAESAR II. Since CAESAR II does not have the provision to write all the restraint types in one 

element, Translator writes the first four restraints in one element and the balance two restraints 
are filled in the available free element by clearly indicating the Anchor Node number. 

4. Transfers flexible anchors with displacements as listed below 

a. Transfers flexible anchors as six flexible restraints. 

b. Transfers four restraints in one element and the last two restraints on the next available 
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free element. 

c. Creates a unique connection node with the available free number (1 to 32000) and writes 

the displacement details in the vectors 1 through 9 corresponding to CAEPIPE 

temperature (T1 through T9). 

d. Displacements for to T10, Seismic, Seismic 2, Seismic 3, Wind 1, Wind 2, Wind 3, Wind 
4 and Settlement are not transferred to CAESAR II as CAESAR II does not have 
provision to define the same. Accordingly Translator will report the message into the 
.log file. 

e. Writes the same CNODE number to all the six flexible restraints. 

5. Transfers flexible anchors and displacements defined in Local Coordinate System (LCS) as 
follows. 

a. Transfers flexible anchors as six flexible restraints in Global coordinate system and report 
the same in to the log file. 

b. Transfers four restraints in one element and the last two restraints on the next available 

free element. 

c. Creates a unique connection node with the available free number (1 to 32000) and writes 

the displacement details in Global coordinates in the vectors 1 through 9 corresponding 

to CAEPIPE temperature (T1 through T9) and notify the user by writing the message in to 

the log file. 

d. Displacement due to T10, Seismic and Settlement will not be transferred to CAESAR II 
as CAESAR II does not have provision to define the same. Accordingly Translator 
will report the message into the .log file. 

e. Writes the same CNODE number to all the six flexible restraints. 

Branch SIF 

Transfers Branch SIF as SIF & TEES to CAESAR II. The table below shows the CAEPIPE Branch SIF 

and the corresponding CAESAR II SIF & TEES. 
 

Branch SIF in CAEPIPE SIF & TEES in CAESAR II Internal Ref. number in CAESAR II 

Welding Tee Welding Tee 3 

Reinforced Fabricated Tee Reinforce Fabricated Tee 1 

Unreinforced Fabricated Tee Unreinforced Fabricated Tee 2 

Weldolet Weldolet 5 

Extruded Welding Tee Extruded Welding Tee 6 

Sweepolet Sweepolet 4 

Branch Connection Full Encirclement 17 

Concentrated Mass (CMASS) 

Transfers CMASS as Rigid Element with 0.1mm length. CAESAR II does not have a separate element to 

define a concentrated mass and hence the Translator simulates the CMASS as a Rigid Element 
in CAESAR II. The following is the algorithm used for transferring the CMASS to CAESAR II. 

a. Since CMASS in CAEPIPE is defined as a nodal property and does not have physical length the 

Translator assumes the length as 0.1mm for the simulated Rigid Element in CAESAR II. 

b. The length thus assumed is then adjusted by reducing the length of the preceding element by 
0.1mm. 
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c. Translator will not transfer the CMASS information to CAESAR II, if the preceding element is 
a Bend and will be reported to .log file. 

d. Translator will not transfer the CMASS details to CAESAR II, if there is no preceding element (i.e. 

CMASS placed at the disconnected “From” node) and will be reported to the .log file. 

Constant Support 

Transfers Constant Support as Hanger to CAESAR II by specifying a very small allowable travel. (i.e. 
0.1 in) as stated in Chapter 3, Restraints of CAESAR II – Applications Guide. 

Flange 

Transfers Flange as Rigid Element to CAESAR II. The following is the algorithm used to transfer the 

flange details to CAESAR II. 

a. Since Flange in CAEPIPE is defined as a nodal property and does not have physical length, 
Translator assumes the length as 0.1mm for the simulated Rigid Element in CAESAR II. 

b. The length thus assumed is then adjusted by reducing the length of preceding element by 0.1mm. 

c. Translator will not transfer the flange details to CAESAR II, if the preceding element is a Bend 
and will be reported to .log file. 

d. Translator will not transfer the flange details to CAESAR II, if there is no preceding element (i.e. 

flange placed at the disconnected “From” node) and will be reported to the .log file. 

Force 

Transfers Force as Force/Moment to CAESAR II. Translator writes the Force information to CII as follows. 

a. If the number of thermal loads in CAEPIPE is less than 4 and the Force/Moment is defined as 

part of Sustained load, then Translator writes the Force/Moment information to vector 4  of 
CAESAR II input with Temperature 4 as Reference temperature of CAPIPE and Pressure 4 as 

maximum pressure among P1, P2 and P3 of CAEPIPE. 

b. On the other hand, if the force is defined as part of Expansion Load, then it will be written to the 
corresponding vector of Force/Moment input of CAESAR II. User has to create a separate load 

combination to view the results along with Force/Moment load in CAESAR II. Refer 

CAESAR II documentation for more info on creating load combinations. 

Force Spectrum Load 

Translator will not transfer the force spectrum load to CAESAR II, as its batch input does not support this 
feature. 

Guide 

Transfers Guide as Guide/Restraints to CAESAR II. The following is the algorithm used for transferring 

the Guide details to CAESAR II. 

a. Transfer as double-acting restraints with or without specified gap. 

b. Guide placed in the horizontal or skewed pipe will be transferred as two restraints orthogonal to 

pipe axis. 

c. Guide placed in the vertical pipe will be transferred as “Guide” in CAESAR II. 

Generic Support 

Generic Support from CAEPIPE along with its displacements will not be transferred to CAESAR II as 
CAESAR II does not have an equivalent element. Accordingly, Translator writes them in log file to notify 
the users. 
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Hanger 

Transfers Hanger as Hanger to CAESAR II. Since the hanger selection algorithm of CAEPIPE is slightly 

different from the CAESAR II, it was observed during the Verification and Validation of the Translator (see 

Section 7.0) that the results produced by CAEPIPE and CAESAR II is different (i.e., for the test problems 

reported in Section 7.0, CAESAR II selected the smallest single spring that satisfies all design 

requirements, whereas CAEPIPE selected the larger spring to be on more conservative side, if two or 
more spring options are feasible). Hence, at this time, in order to obtain almost identical results from 

CAEPIPE and CAESAR II for a typical piping problem with hangers, we recommend the user of this 

Translator to manually model the “hanger” (i.e., the internally selected variable spring hanger) of CAEPIPE 
as a “User-defined hanger” in CAESAR II input file with the values for “Hot Load” and “Spring Rate” as 
those reported in the Hanger Report of CAEPIPE. Refer Appendix D for details on entering the “Hot Load” 
and “Spring Rate” manually to CAESAR II. 

 

Hangers in CAEPIPE Hangers in CAESAR II Internal Ref. Number 
ABB-PBS Not Available  
Basic Engineers Basic Engineers 10 

Bergen-Paterson Bergen Power 2 

Bergen-Paterson (L) Bergen Power 2 

BHEL Hyderabad BHEL 14 
 

BHEL Trichy BHEL 14 

Borrello Not Available  
Carpenter & Paterson Carpenter & Paterson 16 

Comet Comet 17 

Corner & Lada Not Available  
Dynax Not Available  
Elcen Not Available  
Fee & Mason Not Available  
Flexider Flexider 15 

Fronek Fronek 6 

Grinnell PSS-Grinnell 1 

Hydra Hydra 18 

Lisega Lisega 5 

Mitsubishi Not Available  
Myricks Myricks 20 

NHK Not Available  
Nordon Not Available  
Piping Services Piping Services 9 

Piping Tech & Products Piping Technology 7 

Sanwa Tekki Not Available  
Sarathi Sarathi 19 

Spring Supports Not Available  
SSG Not Available  

Please note, if the corresponding Hanger Catalog for CAESAR II is not available, the Translator 
replaces the same with CAESAR II Hanger selected from the list through “Options->Default CII 
Hangers and Materials” of the KP2CII Translator. 

Harmonic Load 

Translator will not transfer the harmonic load to CAESAR II as the batch input does not support 
this feature. 
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Jacketed End Cap 

At this time, Translator will not transfer the Jacketed End Cap to CAESAR II. 

Limit Stop 

Transfers Limit Stop as Single/Double acting Restraint to CAESAR II. The following is the algorithm used 
in transferring the Limit Stop to CAESAR II. For clarity, assume the direction of Limit Stop as Global Y 

(i.e., 0,1,0) 

a. If the Upper Limit is “NONE” and the Lower Limit >= 0 in CAEPIPE, then the Translator will 
transfer as “+Y” Restraint in CAESAR II with gap as specified in Lower Limit of CAEPIPE. 

b. If the Upper Limit >=0 and the Lower Limit is “NONE” in CAEPIPE, then the Translator will 
transfer as “-Y” Restraint in CAESAR II with gap value as specified in Upper Limit of CAEPIPE. 

c. If the Upper Limit > 0 and Lower Limit < 0, then the Translator will transfer as “+Y” restraint 
with gap as absolute value specified in Lower Limit and “-Y” restraint with gap as absolute 
value specified in Upper Limit. 

d. If the Upper Limit >0 and the Lower Limit > 0, then the Translator will transfer as “Y” restraint 

without gap and the same will be reported to the .log file. 

e. If the Upper Limit < 0 and Lower Limit < 0, then the Translator will transfer as “Y” restraint without 

gap and the same will be reported to the .log file. 

Nozzle 

Transfers Nozzle as Nozzle to CAESAR II. Transfers both WRC  – 297 and API  650 Nozzle from 

CAEPIPE to CAESAR II. 

Restraint 

Transfers restraint as double-acting Restraint to CAESAR II. The types of restraint transferred from 

CAEPIPE to CAESAR II are listed below. 

a. Transfers “X” restraint as “X” restraint in CAESAR II with stiffness as rigid. 

b. Transfers “Y” restraint as “Y” restraint in CAESAR II with stiffness as rigid. 

c. Transfers “Z” restraint as “Z” restraint in CAESAR II with stiffness as rigid. 

Rod Hanger 

Transfers Rod Hanger as single-acting Restraint to CAESAR II. If “Y” axis is vertical in CAEPIPE, then the 
Translator will transfer the Rod Hanger as “+Y” restraint to CAESAR II. If the “Z” axis is vertical 
in CAEPIPE, then the Translator will transfer the Rod Hanger as “+Z” restraint to CAESAR II. 

Skewed Restraint 

Transfers Skewed  Restraint  as  double-acting  Restraints to  CAESAR  II  with  stiffnesses identical  to 

CAEPIPE stiffnesses. 

The following are the restraint type used for transferring from CAEPIPE to CAESAR II. 

a. Transfers as “X” restraint, if the direction is (1,0,0) and the type=”Translational” 

b. Transfers as “Y” restraint, if the direction is (0,1,0) and the type=”Translational” 

c. Transfers as “Z” restraint, if the direction is (0,0,1) and the type=”Translational” 

d. Transfers as “X(Xcomp,Ycomp,Zcomp), if the direction is skewed and the type = “Translational” 

e. Transfers as “RX” restraint, if the direction is (1,0,0) and the type=”Rotational” 
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f. Transfers as “RY” restraint, if the direction is (0,1,0) and the type=”Rotational” 

g. Transfers as “RZ” restraint, if the direction is (0,0,1) and the type=”Rotational” 

h. Transfers as “RX(Xcomp,Ycomp,Zcomp), if the direction is skewed and the type = “Rotational” 

Snubber 

Transfers Snubber as Directional Snubber (Restraint) to CAESAR II. 

a. Transfers as “XSNB(1,0,0)” restraint, if the direction is 1,0,0 

b. Transfers as “XSNB(0,1,0)” restraint, if the direction is 0,1,0 

c. Transfers as “XSNB(0,0,1)” restraint, if the direction is 0,0,1 

d. Transfers as “XSNB(Xcomp,Ycomp,Zcomp), if the direction is skewed. 

Spider 

Transfers Spider as Spider to CAESAR II. 

Threaded Joint and Weld 

Transfers Threaded Joint and Weld as SIF & TEES to CAESAR II. The following are the types of 
Threaded Joint and Weld in CAEPIPE and the corresponding SIF & TEES in CAESAR II. 

 

Threaded Joint and Weld n CAEPIPE SIF & TEES in CAESAR II 

Threaded Joint Threaded Joint 

Buttweld Buttweld 

Fillet Weld Double weld 

Tapered Tapered 

Concave Lap Joint 

User SIF 

Transfers User SIF as SIF & TEES to CAESAR II. Transfers the value of Inplane SIF and Outplant SIF to 

CAESAR II with intersection type code as “Null”. 

Material 

Translator checks the description of the material entered in CAEPIPE with the field “CAEPIPEmat” of 
table “material” from the Material Mapping DB (material.mdb) supplied along with the software to 
identify the corresponding CAESAR II material. Please note, if the CAESAR II material corresponding to 
the material description entered in CAEPIPE is not available in the mapping DB, then by default, the 
Translator will transfer the CAESAR II material selected from the list through “Options->Default CII 
Hanger and Material” from KP2CII. User can add new description to this table, to enable the transfer of 
user-defined material from CAEPIPE to CAESAR II. Refer Appendix A for details on modifying the 
Material Mapping DB and Hanger Mapping DB. 
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6.0 Points to be considered while comparing results 

The most important task to be performed for producing identical results between CAEPIPE and CAESAR 

II is to configure manually in CAESAR II the analysis option in line with CAEPIPE analysis option. Since 

CAESAR II batch input does not have the provision to store this information, the Translator cannot transfer 
these options electronically. This section describes in detail about setting the analysis options in CAESAR 

II configuration file identical to those options set in CAEPIPE. 

The following are the steps to be followed to set the analysis options in CAESAR II corresponding to 

CAEPIPE analysis options. 

6.1 Code 

On this tab you can choose the piping code and also set options for that piping code. 

  

a. The left figure above shows the analyses option related to code. The piping code to be used for 
performing analysis can be selected from the "Piping code" drop-down combo box of CAEPIPE. 
The following is the procedure in CAESAR II to select the Piping Code corresponding to 

CAEPIPE. 

1. From the “Tools” menu, select “Configure/Setup” 

2. Select the tab “SIF’s and Stresses” 

3. From the “Default Code” drop-down combo box, select the Piping Code corresponding to 

CAEPIPE Piping Code. 

b. The analysis option in CAESAR II corresponding to CAEPIPE “Include axial force in stress 
calculations” as shown in left figure below can be set as follows 

1. From the “Tools” menu, select “Configure/Setup” 

2. Select the tab “SIF’s and Stresses” 

3. From the “ADD F/A in Stresses” drop-down combo box, select the option “No” if it is 
turned off in CAEPIPE and select the option “Yes” if it is turned on in CAEPIPE as shown 
in right figure below. 
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c. The analysis option in CAESAR II corresponding to CAEPIPE “Use liberal allowable stresses” as 

shown in left figure below can be set as follows 

1. From the “Tools” menu, select “Configure/Setup” 

2. Select the tab “SIF’s and Stresses” 

3. “Uncheck” the option “Liberal Expansion Stress Allowable”, if it is turned off in CAEPIPE 
and “Check” the option, if it is turned on in CAEPIPE. 

 

  



15 
 

6.2 Temperature 

On this tab you can set the options related to thermal loads 

  

a. The analysis option in CAESAR II corresponding to CAEPIPE “Reference temperature” as shown in left 

figure above can be set as follows 

1. From the “Tools” menu, select “Configure/Setup” 

2. Select the tab “Computational Control” 

3. Enter the “Reference temperature” of CAEPIPE at the “Default Ambient Temperature” as 
shown in right figure above. 

6.3 Pressure 

In CAEPIPE, the options related to pressure loads can be set through this tab.

  

a. The analysis option in CAESAR II corresponding to CAEPIPE “PD/4T” as shown in left figure above 

can be set as follows 

1. From the “Tools” menu, select “Configure/Setup” 

2. Select the tab “SIF’s and Stresses” 

3. “Check” the option “Use PD.4t” as shown in right figure above, if the radio button “PD/4T” 
is selected in CAEPIPE. 
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b. The analysis option in CAESAR II corresponding to CAEPIPE “Include Bourdon Effect” as shown in left 

figure above can be set as follows 

1. From the “Tools” menu, select “Configure/Setup” 

2. Select the tab “Computational Control” 

3. Select the option “None” from “Bourdon Pressure” as shown in right figure above, if it is 
“Unchecked” in CAEPIPE and select the option “Trans + Rot”, if  it is “Checked” in 
CAEPIPE. 

  

c. The analysis option in CAESAR II corresponding to CAEPIPE “Use pressure correction for bends” as 

shown in left figure above can be set as follows 

4. From the “Tools” menu, select “Configure/Setup” 

5. Select the tab “Computational Control” 

6. Select the option “No” from “Use Pressure Stiffening” as shown in right figure above, if it 

is “Unchecked” in CAEPIPE and select the option “Yes”, if it is “Checked” in CAEPIPE. 
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6.4 Dynamics 

In CAEPIPE, the options related to dynamic analysis can be set through this tab.

  

a. The analysis option in CAESAR II corresponding to CAEPIPE “Include missing mass correction” as 

shown in left figure above can be set as follows 

1. From the “Tools” menu, select “Configure/Setup” 

2. Select the tab “Computational Control” 

3. Select the option “Extracted” from “Missing Mass ZPA” as shown in right figure above, if it 

is “Checked” in CAEPIPE and select “Spectrum”, if it is unchecked in CAEPIPE. 

6.5 Miscellaneous 

In CAEPIPE, the miscellaneous options can be set through this tab. 

  

a. The analysis option in CAESAR II corresponding to CAEPIPE “Include hanger stiffness” as shown in 

left figure above can be set as follows 

1. From the “Tools” menu, select “Configure/Setup” 

2. Select the tab “Computational Control” 

3. “Uncheck” the option “Ignore Spring Hanger Stiffness” as shown in right figure above, if it 
is “Checked” in CAEPIPE and “Check” in CAESAR II, if it is “Unchecked” in CAEPIPE. 
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b. The analysis option in CAESAR II corresponding to CAEPIPE “Vertical Direction” as shown in left figure 

above can be set as follows 

1. From the “Tools” menu, select “Configure/Setup” 

2. Select the tab “Geometry Directives” 

3. “Uncheck” the option “Z-Axis Vertical” as shown in right figure above, if the radio button 
“Y” is selected in CAEPIPE and “Check” in CAESAR II, if the radio button “Z” is selected 
in CAEPIPE. 

6.6 Adding missing information to CAESAR II 

To produce identical results between CAEPIPE and CAESAR II, additional information may need to be 

input into CAESAR II model before analysis. During the transfer of CAEPIPE model file to CAESAR II, the 

Translator will clearly report the missing items/information to “.log” file. The primary name of the log file 
is identical to primary name of the batch input file “.cii” entered during the transfer. In addition, the log 
file will be stored in the same directory, where the path of the batch input file “.cii” is entered during 
the transfer. The information stored in this log file should be read carefully by the user of the 
Translator and should be added to the CAESAR II input. Failing to do so will affect the results and will 
lead to mismatch in the results between the software. 

The following is the procedure to add the missing items, if the user finds a message in log file as 

“FLANGE at Node 10 with mass 55.000 kg is not transferred”. 

1. Import and convert the batch input file “.cii” created using the Translator into CAESAR II 
binary format through “Tools->External Translators->CAESAR II Neutral File” as shown in 
left figure below. 

2. From the figure shown in right below, select the radio button “Convert Neutral File to CAESAR II 
Input File” and then press the button “Browse” and select the “.cii” file. 
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3. Upon  successful  conversion,  the  user  will  get  a  message  “The  conversion  was completed 
successfully”. 

4. Now, open the binary file (._A) through “File->Open”. 

5. From the “Input” menu, select piping as shown in the figure below. 

 

 

6. Navigate to the required element. In this case node number 10. 

7. Press the icon “Break”. You will see a dialog box as shown in figure below.
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8. Enter a unique node number at “New Node Number” field and enter the distance as 0.1mm as 

shown in figure above and press the button “OK”. 

9. Then from the spread sheet input, double click on “Rigid” check box and enter the weight of the 
Rigid Element as “55.000” kg as reported in the log file. 

10. Similarly,  follow  the  same  steps  1  through  9,  in  case  if  you  find  a  similar  message  for 
Concentrated Mass (CMASS). 

11. For other elements/information, refer the CAESAR II – Technical Reference Manual, Applications 

Manual and User Guide for details on modeling and analysis of certain specific elements. 

Note: 

Translator transfers the model from CAEPIPE to CAESAR II batch input with UNITS setting 

corresponding to CAEPIPE units setting. However, for displaying the results, CAESAR II always uses 

the units setting defined in the unit file (.FIL) of CAESAR II configuration settings as shown in figure 

above. Hence, to have a identical units in CAESAR II, we recommend you to create a unit file 

corresponding to CAEPIPE units setting and assign them in the CAESAR II configuration or else 

change the CAEPIPE units corresponding to CAESAR II defaults units and before viewing/comparing 

the results. 

Refer to Appendix C for details on, how CAESAR II units are mapped against with CAEPIPE units for 
transferring the model. 
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7.0 Verification and Validation of Translator 

7.1 General 

This section provides the comparison results between CAEPIPE and CAESAR II. To study and 

understand the intricate details of CAESAR II, we categorized the models into two groups. 

1. Study Models and 

2. Live Project Models 

Note: 

The models chosen for testing and comparing the results are included with the installation media for 
reference. Due to space constraints in listing the results for all nodes, the table listed below shows values 
for Total weight, Support loads under different loading conditions and Frequencies. Please note that when 
all parameters are identical between the CAEPIPE and CAESAR II stress models, the Support loads and 
Frequencies should not differ between CAEPIPE and CAESAR II as long as the same flexibility factors for 
piping components such as Bends, Tees, etc. are used in both programs. In order to achieve this, during 
comparison, along with other parameters, the piping code was selected as either ASME B31.1 or ASME 
B31.3 with the flexibility factors calculated as per Appendix D of the respective code. 

As stated in the subsection titled “Hanger” in the Section titled “Reference” from this document, due to the 
differences in the hanger selection algorithm between CAEPIPE and CAESAR II, the results were slightly 
different between CAEPIPE and CAESAR II. Hence, in order to match the results between CAEPIPE and 
CAESAR II, the “Hot Load” and the “Spring Rate” obtained from the hanger results report of CAEPIPE 
were entered manually at the “Cold Load” and “Spring Rate” fields of CAESAR II hanger input to get 
identical results between CAEPIPE and CAESAR II. Hence, if you recreate the “.cii” file using the 
Translator for your testing, we recommend you to update the above said parameters manually in 
CAESAR II before performing the analysis. We also recommend you to add the missing items/information 
reported in the log file of the Translator to CAESAR II binary model before performing the analysis. 

7.2 Study Models 

To study and understand the way CAESAR II performs analysis for different types of elements under 
different loading conditions, 27 problems were modeled manually with an increasing complexity. (i.e., 
three Elements with simple load condition at the beginning and with a number of elements with 

complex loading conditions at the end). 

The analyses were performed in both the software and the results thus obtained were compared against 
each other.  Models in CAESAR II were fine-tuned to eliminate the mismatching of results and re- 
performed the analyses. The knowledge gathered from the above study was then used as the algorithm 

for developing the Translator. 

To test the implemented algorithm, the models were then transferred electronically to CAESAR II and the 

analyses were performed again. The results thus obtained were compared against the manually modeled 

CAESAR II models and then with the CAEPIPE results. It was observed during the comparison that the 

results were identical between CAEPIPE and CAESAR II. The results are listed below for your reference. 
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About Model-001 

This model has the following 

a. Three Pipe elements with 4 node points starting from node 10. The length of each piping element 
is 1m. 

b. Rigid anchor at node 10. 

c. Concentrated mass of 1000 kg at node 40. 

d. Design pressure and design temperature are 0 kg/cm2 and 148.9
0 
C respectively. 

e. A53 Grade B material and 10” Nominal diameter section are used. 

f. Insulation, Fluid density and Pipe material density are taken to be zero. The pictorial representation 
of the CAEPIPE model is shown below. 

  

Name of the Model Model – 001 
Analysis Options in CAEPIPE 
1 Code – B 31.3 (2016) 

2 Do not Include axial Force in Stress Calculations 

3 Do not use liberal allowable stress 

4 Reference Temperature = 20
0
c 

5 Number of Thermal Cycles = 7000 

6 Use pd/4t 

7 Do not include bourdon effect 

8 Do not use pressure correction for bends 

9 Do not include missing mass correction 

10 Do not use friction in dynamic analysis 

11 Y – Vertical 

Total Weight (Kg)  
CAEPIPE 1000 

CAESAR II 1000 

Support Load (Sustained) 
 Node Fx (Kg) Fy (Kg) Fz (Kg) Mx (Kg-m) My (Kg-m) Mz (Kg-m) 

CAEPIPE 10 0 -1000 0 0 0 -3000 

CAESAR II 10 0 -1000 0 0 0 -2998.8 

Operating Case 
 Node Fx (Kg) Fy (Kg) Fz (Kg) Mx (Kg-m) My (Kg-m) Mz (Kg-m) 

CAEPIPE 10 0 -1000 0 0 0 -3000 

CAESAR II 10 0 -1000 0 0 0 -2998.8 

Frequencies (in Hz)  
Mode Number CAEPIPE CAESAR II 

1 7.586 7.584  
2 7.586 7.584  
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About Model-002 

This model shown below is the same as Model-001 above, with the following modifications. 

a. Concentrated mass at node 40 is replaced by Rigid anchor. 

b. Two concentrated masses of 500 kg each are added at nodes 20 and 30. 

c. An intermediate node is inserted at mid point between nodes 20 and 30. 

  
 

Name of the Model Model – 002 

Analysis Options in CAEPIPE 
1 Code – B 31.3 (2016) 

2 Do not Include axial Force in Stress Calculations 

3 Do not use liberal allowable stress 

4 Reference Temperature = 20
0
c 

5 Number of Thermal Cycles = 7000 

6 Use pd/4t 

7 Do not include bourdon effect 

8 Do not use pressure correction for bends 

9 Do not include missing mass correction 

10 Do not use friction in dynamic analysis 

11 Y – Vertical 

Total Weight (Kg)  
CAEPIPE 1000 

CAESAR II 1000 

Support Load (Sustained) 
 Node Fx (Kg) Fy (Kg) Fz (Kg) Mx (Kg-m) My (Kg-m) Mz (Kg-m) 

CAEPIPE 10 0 -500 0 0 0 -333 

CAESAR II 10 0 -500 0 0 0 -333.2 

        
CAEPIPE 40 0 -500 0 0 0 333 

CAESAR II 40 0 -500 0 0 0 333.2 

Operating Case 
 Node Fx (Kg) Fy (Kg) Fz (Kg) Mx (Kg-m) My (Kg-m) Mz (Kg-m) 

CAEPIPE 10 -384383 -500 0 0 0 -333 

CAESAR II 10 -384240 -500 0 0 0 -333.2 

        
CAEPIPE 40 384383 -500 0 0 0 333 

CAESAR II 40 384240 -500 0 0 0 333.2 

Frequencies (in Hz)  
Mode Number CAEPIPE CAESAR II 

1 70.777 70.764 
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About Model-003 

This model shown below is the same as Model-002 above with the following modifications. 

d. Rigid anchors at nodes 10 and 40 are replaced by flexible anchor with the following stiffnesses 

kx=ky=kz=1000kg/mm and kxx=kyy=kzz=1000kg-m/deg. 

e.   
 

Name of the Model Model – 003 

Analysis Options in CAEPIPE 
1 Code – B 31.3 (2016) 

2 Do not Include axial Force in Stress Calculations 

3 Do not use liberal allowable stress 

4 Reference Temperature = 20
0
c 

5 Number of Thermal Cycles = 7000 

6 Use pd/4t 

7 Do not include bourdon effect 

8 Do not use pressure correction for bends 

9 Do not include missing mass correction 

10 Do not use friction in dynamic analysis 

11 Y – Vertical 

Total Weight (Kg)  
CAEPIPE 1000 

CAESAR II 1000 

Support Load (Sustained) 
 Node Fx (Kg) Fy (Kg) Fz (Kg) Mx (Kg-m) My (Kg-m) Mz (Kg-m) 

CAEPIPE 10 0 -500 0 0 0 -13 

CAESAR II 10 0 -500 0 0 0 -13 

        
CAEPIPE 40 0 -500 0 0 0 13 

CAESAR II 40 0 -500 0 0 0 13 

Operating Case 
 Node Fx (Kg) Fy (Kg) Fz (Kg) Mx (Kg-m) My (Kg-m) Mz (Kg-m) 

CAEPIPE 10 -2264 -500 0 0 0 -13 

CAESAR II 10 -2263 -500 0 0 0 -13 

        
CAEPIPE 40 2264 -500 0 0 0 13 

CAESAR II 40 2263 -500 0 0 0 13 

Frequencies (in Hz)  
Mode Number CAEPIPE CAESAR II 

1 18.83 18.823 

2 18.83 18.823 

3 22.254 22.245 
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About Model-004 

This model shown below is the same as Model-003 above with the following modifications. 

a. Insulation density of section as 400 kg/m3 and 

b. Insulation thickness of section as 100mm. 

  
 

Name of the Model Model – 004 

Analysis Options in CAEPIPE 
1 Code – B 31.3 (2016) 

2 Do not Include axial Force in Stress Calculations 

3 Do not use liberal allowable stress 

4 Reference Temperature = 20
0
c 

5 Number of Thermal Cycles = 7000 

6 Use pd/4t 

7 Do not include bourdon effect 

8 Do not use pressure correction for bends 

9 Do not include missing mass correction 

10 Do not use friction in dynamic analysis 

11 Y – Vertical 

Total Weight (Kg)  
CAEPIPE 1140.6 

CAESAR II 1140.6 

Support Load (Sustained) 
 Node Fx (Kg) Fy (Kg) Fz (Kg) Mx (Kg-m) My (Kg-m) Mz (Kg-m) 

CAEPIPE 10 0 -570 0 0 0 -14 

CAESAR II 10 0 -570 0 0 0 -14.4 

        
CAEPIPE 40 0 -570 0 0 0 14 

CAESAR II 40 0 -570 0 0 0 14.4 

Operating Case 
 Node Fx (Kg) Fy (Kg) Fz (Kg) Mx (Kg-m) My (Kg-m) Mz (Kg-m) 

CAEPIPE 10 -2264 -570 0 0 0 -14 

CAESAR II 10 -2263 -570 0 0 0 -14.4 

        
CAEPIPE 40 2264 -570 0 0 0 14 

CAESAR II 40 2263 -570 0 0 0 14.4 

Frequencies (in Hz)  
Mode Number CAEPIPE CAESAR II 

1 17.795 17.788 

2 17.795 17.788 

3 20.841 20.832 
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About Model-005 

This model shown below is the same as Model-004 above with the following modification. 

a. Fluid density as 1000 kg/m3. 

  
 

Name of the Model Model – 005 

Analysis Options in CAEPIPE 
1 Code – B 31.3 (2016) 

2 Do not Include axial Force in Stress Calculations 

3 Do not use liberal allowable stress 

4 Reference Temperature = 20
0
c 

5 Number of Thermal Cycles = 7000 

6 Use pd/4t 

7 Do not include bourdon effect 

8 Do not use pressure correction for bends 

9 Do not include missing mass correction 

10 Do not use friction in dynamic analysis 

11 Y – Vertical 

Total Weight (Kg)  
CAEPIPE 1279.5 

CAESAR II 1279.7 

Support Load (Sustained) 
 Node Fx (Kg) Fy (Kg) Fz (Kg) Mx (Kg-m) My (Kg-m) Mz (Kg-m) 

CAEPIPE 10 0 -640 0 0 0 -16 

CAESAR II 10 0 -640 0 0 0 -15.7 

        
CAEPIPE 40 0 -640 0 0 0 16 

CAESAR II 40 0 -640 0 0 0 15.7 

Operating Case 
 Node Fx (Kg) Fy (Kg) Fz (Kg) Mx (Kg-m) My (Kg-m) Mz (Kg-m) 

CAEPIPE 10 -2264 -640 0 0 0 -16 

CAESAR II 10 -2263 -640 0 0 0 -15.7 

        
CAEPIPE 40 2264 -640 0 0 0 16 

CAESAR II 40 2263 -640 0 0 0 15.7 

Frequencies (in Hz)  
Mode Number CAEPIPE CAESAR II 

1 16.922 16.914 

2 16.922 16.914 

3 19.679 19.670 
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About Model-006 

This model shown below is the same as Model-005 above with the following modification. 

a. Density of material as 7833 kg/m3. 

  
 

Name of the Model Model – 006 

Analysis Options in CAEPIPE 
1 Code – B 31.3 (2016) 

2 Do not Include axial Force in Stress Calculations 

3 Do not use liberal allowable stress 

4 Reference Temperature = 20
0
c 

5 Number of Thermal Cycles = 7000 

6 Use pd/4t 

7 Do not include bourdon effect 

8 Do not use pressure correction for bends 

9 Do not include missing mass correction 

10 Do not use friction in dynamic analysis 

11 Y – Vertical 

Total Weight (Kg)  
CAEPIPE 1566.4 

CAESAR II 1566.5 

Support Load (Sustained) 
 Node Fx (Kg) Fy (Kg) Fz (Kg) Mx (Kg-m) My (Kg-m) Mz (Kg-m) 

CAEPIPE 10 0 -783 0 0 0 -19 

CAESAR II 10 0 -783 0 0 0 -18.5 

        
CAEPIPE 40 0 -783 0 0 0 19 

CAESAR II 40 0 -783 0 0 0 18.5 

Operating Case 
 Node Fx (Kg) Fy (Kg) Fz (Kg) Mx (Kg-m) My (Kg-m) Mz (Kg-m) 

CAEPIPE 10 -2264 -783 0 0 0 -19 

CAESAR II 10 -2263 -783 0 0 0 -18.5 

        
CAEPIPE 40 2264 -783 0 0 0 19 

CAESAR II 40 2263 -783 0 0 0 18.5 

Frequencies (in Hz)  
Mode Number CAEPIPE CAESAR II 

1 15.458 15.452 

2 15.458 15.452 

3 17.789 17.784 
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About Model-007 

This model shown below is the same as Model-006 above with the following modification. 

a.   Internal fluid pressure of 50 kg/cm2. 

  
 

Name of the Model Model – 007 

Analysis Options in CAEPIPE 
1 Code – B 31.3 (2016) 

2 Do not Include axial Force in Stress Calculations 

3 Do not use liberal allowable stress 

4 Reference Temperature = 20
0
c 

5 Number of Thermal Cycles = 7000 

6 Use pd/4t 

7 Do not include bourdon effect 

8 Do not use pressure correction for bends 

9 Do not include missing mass correction 

10 Do not use friction in dynamic analysis 

11 Y – Vertical 

Total Weight (Kg)  
CAEPIPE 1566.4 

CAESAR II 1566.5 

Support Load (Sustained) 
 Node Fx (Kg) Fy (Kg) Fz (Kg) Mx (Kg-m) My (Kg-m) Mz (Kg-m) 

CAEPIPE 10 0 -783 0 0 0 -19 

CAESAR II 10 0 -783 0 0 0 -18.5 

        
CAEPIPE 40 0 -783 0 0 0 19 

CAESAR II 40 0 -783 0 0 0 18.5 

Operating Case 
 Node Fx (Kg) Fy (Kg) Fz (Kg) Mx (Kg-m) My (Kg-m) Mz (Kg-m) 

CAEPIPE 10 -2264 -783 0 0 0 -19 

CAESAR II 10 -2263 -783 0 0 0 -18.5 

        
CAEPIPE 40 2264 -783 0 0 0 19 

CAESAR II 40 2263 -783 0 0 0 18.5 

Frequencies (in Hz)  
Mode Number CAEPIPE CAESAR II 

1 15.458 15.452 

2 15.458 15.452 

3 17.789 17.781 
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About Model-011 

This model shown below is the same as Model-007 above with the following modifications. 

a. Long radius bend at node 50. 

b. Straight pipe of 2m lengths and 

c. Flexible anchor at node 60 with stiffnesses kx=ky=kz=1000 kg/mm and kxx=kyy=kzz=1000 kg- 
m/deg. 

 

  
 

Name of the Model Model – 011 
Analysis Options in CAEPIPE 
1 Code – B 31.3 (2016) 

2 Do not Include axial Force in Stress Calculations 

3 Do not use liberal allowable stress 

4 Reference Temperature = 20
0
c 

5 Number of Thermal Cycles = 7000 

6 Use pd/4t 

7 Do not include bourdon effect 

8 Do not use pressure correction for bends 

9 Do not include missing mass correction 

10 Do not use friction in dynamic analysis 

11 Y – Vertical 

Total Weight (Kg)  
CAEPIPE 2101.9 

CAESAR II 2101.2 

Support Load (Sustained) 
 Node Fx (Kg) Fy (Kg) Fz (Kg) Mx (Kg-m) My (Kg-m) Mz (Kg-m) 

CAEPIPE 10 0 -1185 0 -669 0 -421 

CAESAR II 10 0 -1185 0 -669.3 0 -421 

        
CAEPIPE 60 0 -917 0 -784 0 -308 

CAESAR II 60 0 -916 0 -784 0 -308 

Operating Case 
 Node Fx (Kg) Fy (Kg) Fz (Kg) Mx (Kg-m) My (Kg-m) Mz (Kg-m) 

CAEPIPE 10 -866 -1185 -413 -669 61 -421 

CAESAR II 10 -866 -1185 -413 -669.3 60.9 -421 
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CAEPIPE 60 866 -917 413 -784 -141 -308 

CAESAR II 60 866 -916 413 -784 -140.8 -308 
 

Frequencies (in Hz) 
Mode Number CAEPIPE CAESAR II 

1 3.79 3.784 

2 11.819 11.812 

3 13.073 13.068 

4 19.189 19.151 

5 25.437 25.408 
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About Model-012 

This model shown below is the same as Model-011 above with the following modification. 

a.   Flexible anchor at node 60 is replaced by rigid anchor. 

 

  
 

Name of the Model Model – 012 

Analysis Options in CAEPIPE 
1 Code – B 31.3 (2016) 

2 Do not Include axial Force in Stress Calculations 

3 Do not use liberal allowable stress 

4 Reference Temperature = 20
0
c 

5 Number of Thermal Cycles = 7000 

6 Use pd/4t 

7 Do not include bourdon effect 

8 Do not use pressure correction for bends 

9 Do not include missing mass correction 

10 Do not use friction in dynamic analysis 

11 Y – Vertical 

Total Weight (Kg)  
CAEPIPE 2101.9 

CAESAR II 2101.2 

Support Load (Sustained) 
 Node Fx (Kg) Fy (Kg) Fz (Kg) Mx (Kg-m) My (Kg-m) Mz (Kg-m) 

CAEPIPE 10 0 -943 0 -47 0 -36 

CAESAR II 10 0 -943 0 -47.4 0 -36.2 

        
CAEPIPE 60 0 -1159 0 -1890 0 276 

CAESAR II 60 0 -1158 0 -1890 0 275.6 

Operating Case 
 Node Fx (Kg) Fy (Kg) Fz (Kg) Mx (Kg-m) My (Kg-m) Mz (Kg-m) 

CAEPIPE 10 -3403 -943 -457 -47 69 -36 

CAESAR II 10 -3402 -943 -457 -47.4 69 -36.2 

        
CAEPIPE 60 3403 -1159 457 -1890 -5045 276 

CAESAR II 60 3402 -1158 457 -1890 -5044.1 275.6 
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Frequencies (in Hz) 
Mode Number CAEPIPE CAESAR II 

1 12.556 12.55 

2 14.430 14.422 

3 18.485 18.474 

4 29.96 29.884 
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About Model-013 

This model shown below is the same as Model-012 above with the following modification. 

a. Short radius bend at node 60. 

b. Vertically downward pipe of length 3m and 

c. Rigid anchor at node 70. 

 

  
 

Name of the Model Model – 013 

Analysis Options in CAEPIPE 
1 Code – B 31.3 (2016) 

2 Do not Include axial Force in Stress Calculations 

3 Do not use liberal allowable stress 

4 Reference Temperature = 20
0
c 

5 Number of Thermal Cycles = 7000 

6 Use pd/4t 

7 Do not include bourdon effect 

8 Do not use pressure correction for bends 

9 Do not include missing mass correction 

10 Do not use friction in dynamic analysis 

11 Y – Vertical 

Total Weight (Kg)  
CAEPIPE 3025.4 

CAESAR II 3025.9 

Support Load (Sustained) 
 Node Fx (Kg) Fy (Kg) Fz (Kg) Mx (Kg-m) My (Kg-m) Mz (Kg-m) 

CAEPIPE 10 10 -1397 -86 -350 75 -432 

CAESAR II 10 10 -1397 -86 -350.4 75.1 -431.8 

        
CAEPIPE 70 -10 -1628 86 -2210 309 -1114 

CAESAR II 70 -10 -1628 86 -2209.5 308.8 -1113.7 
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Operating Case 
 Node Fx (Kg) Fy (Kg) Fz (Kg) Mx (Kg-m) My (Kg-m) Mz (Kg-m) 

CAEPIPE 10 -441 -1297 -419 -381 169 -386 

CAESAR II 10 -440 -1297 -419 -380.8 169.4 -385.7 

        
CAEPIPE 70 441 -1728 419 -1580 -255 -2112 

CAESAR II 70 440 -1728 419 -1579.7 -255.1 -2111.3 

Frequencies (in Hz)  
Mode Number CAEPIPE CAESAR II 

1 3.489 3.482 

2 8.133 8.128 

3 10.827 10.823 

4 12.38 12.354 

5 18.177 18.155 
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About Model-014 

This model shown below is the same as Model-013 above with the following modifications. 

a. Welding tee at node 55 and 

b. Force of 100kg in vertical direction at node 55. 

  

Name of the Model Model – 014 

Analysis Options in CAEPIPE 
1 Code – B 31.3 (2016) 

2 Do not Include axial Force in Stress Calculations 

3 Do not use liberal allowable stress 

4 Reference Temperature = 20
0
c 

5 Number of Thermal Cycles = 7000 

6 Use pd/4t 

7 Do not include bourdon effect 

8 Do not use pressure correction for bends 

9 Do not include missing mass correction 

10 Do not use friction in dynamic analysis 

11 Y – Vertical 

Total Weight (Kg)  
CAEPIPE 3025.6 

CAESAR II 3026.1 

Support Load (Sustained) 
 Node Fx (Kg) Fy (Kg) Fz (Kg) Mx (Kg-m) My (Kg-m) Mz (Kg-m) 

CAEPIPE 10 16 -1576 -125 -478 110 -602 

CAESAR II 10 16 -1576 -125 -477.5 110.2 -601.9 

        
CAEPIPE 70 -16 -2449 125 -3247 457 -1643 

CAESAR II 70 -16 -2448 125 -3246.1 456.4 -1642.4 



36 
 

Operating Case 
 Node Fx (Kg) Fy (Kg) Fz (Kg) Mx (Kg-m) My (Kg-m) Mz (Kg-m) 

CAEPIPE 10 -434 -1476 -459 -508 205 -556 

CAESAR II 10 -434 -1476 -459 -508 204.6 -555.8 

        
CAEPIPE 70 434 -2549 459 -2617 -107 -2641 

CAESAR II 70 434 -2548 459 -2616.3 -107.4 -2640 

Frequencies (in Hz)  
Mode Number CAEPIPE CAESAR II 

1 3.628 3.623 

2 8.172 8.167 

3 10.767 10.762 

4 13.196 13.182 

5 18.395 18.375 
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About Model-015 

This model shown below is the same as Model-014 above with the following modifications. 

a. Two horizontal pipes of length 1m and 

b. Valve between two pipes with 100 kg weight and 600mm length. 

  
 

Name of the Model Model – 015 

Analysis Options in CAEPIPE 
1 Code – B 31.3 (2016) 

2 Do not Include axial Force in Stress Calculations 

3 Do not use liberal allowable stress 

4 Reference Temperature = 20
0
c 

5 Number of Thermal Cycles = 7000 

6 Use pd/4t 

7 Do not include bourdon effect 

8 Do not use pressure correction for bends 

9 Do not include missing mass correction 

10 Do not use friction in dynamic analysis 

11 Y – Vertical 

Total Weight (Kg)  
CAEPIPE 3580 

CAESAR II 3579.6 

Support Load (Sustained) 
 Node Fx (lb) Fy (lb) Fz (lb) Mx (ft-lb) My (ft-lb) Mz (ft-lb) 

CAEPIPE 10 276 -2722 -38 -654 51 -928 

CAESAR II 10 276 -2723 -38 -654 51 -928 

        
CAEPIPE 70 311 -2463 659 864 -1064 294 

CAESAR II 70 311 -2464 659 864 -1064 293 
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CAEPIPE 1020 -587 -4912 -622 -9063 -4031 27555 

CAESAR II 1020 -587 -4913 -622 -9065 -4032 27564 

Operating Case 
 Node Fx (lb) Fy (lb) Fz (lb) Mx (ft-lb) My (ft-lb) Mz (ft-lb) 

CAEPIPE 10 -8877 -2744 -1755 -1140 922 -1072 

CAESAR II 10 -8877 -2745 -1755 -1140 922 -1075 

        
CAEPIPE 70 -3869 -5363 2575 9779 380 31130 

CAESAR II 70 -3869 -5364 2576 9782 380 31134 

        
CAEPIPE 1020 12747 -1990 -820 -17519 -18132 12794 

CAESAR II 1020 12747 -1991 -821 -17522 -18135 12801 

Frequencies (in Hz)  
Mode Number CAEPIPE CAESAR II 

1 8.030 8.023 

2 11.139 11.132 

3 16.276 16.264 

4 19.010 18.988 

5 21.909 21.869 
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About Model-017 

This model shown below is the same as Model-015 above with the following modifications. 

a. Long radius bend at node 1030. 

b. Reducer of length 128 mm between nodes 1015 and 1020. 

c. Horizontal pipe of length 3m in negative z direction and 

d. Rigid anchor at node 1040. 

 
 

Name of the Model Model – 017 

Analysis Options in CAEPIPE 
1 Code – B 31.3 (2016) 

2 Do not Include axial Force in Stress Calculations 

3 Do not use liberal allowable stress 

4 Reference Temperature = 20
0
c 

5 Number of Thermal Cycles = 7000 

6 Use pd/4t 

7 Do not include bourdon effect 

8 Do not use pressure correction for bends 

9 Do not include missing mass correction 

10 Do not use friction in dynamic analysis 

11 Y – Vertical 

Total Weight (Kg)  
CAEPIPE 4227.4 

CAESAR II 4233.4 

Support Load (Sustained) 
 Node Fx (lb) Fy (lb) Fz (lb) Mx (ft-lb) My (ft-lb) Mz (ft-lb) 

CAEPIPE 10 30 -3493 -292 -1717 402 -2532 

CAESAR II 10 30 -3494 -293 -1718 402 -2533 

        
CAEPIPE 70 -352 -5181 858 -8336 -350 3019 

CAESAR II 70 -352 -5182 858 -8340 -349 3019 

        
CAEPIPE 1040 322 -2850 -565 14069 926 4277 

CAESAR II 1040 322 -2851 -566 14079 928 4280 
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Operating Case 
 Node Fx (lb) Fy (lb) Fz (lb) Mx (ft-lb) My (ft-lb) Mz (ft-lb) 

CAEPIPE 10 -2637 -3264 -1233 -1974 996 -2215 

CAESAR II 10 -2636 -3264 -1233 -1975 996 -2216 

        
CAEPIPE 70 -1280 -5799 2738 4474 -3080 10017 

CAESAR II 70 -1282 -5800 2738 4474 -3080 10022 

        
CAEPIPE 1040 3918 -2461 -1505 10624 25214 3256 

CAESAR II 1040 3918 -2462 -1506 10633 25216 3258 

Frequencies (in Hz)  
Mode Number CAEPIPE CAESAR II 

1 4.857 4.849 

2 7.941 7.932 

3 9.659 9.642 

4 10.692 10.663 

5 14.637 14.611 

 
  



41 
 

About Model-018 

This model shown below is the same as Model-017 above with the following modification. 

a.   Hanger at node 1015. 

 
 

Name of the Model Model – 018 

Analysis Options in CAEPIPE 
1 Code – B 31.3 (2016) 

2 Do not Include axial Force in Stress Calculations 

3 Do not use liberal allowable stress 

4 Reference Temperature = 20
0
c 

5 Number of Thermal Cycles = 7000 

6 Use pd/4t 

7 Do not include bourdon effect 

8 Do not use pressure correction for bends 

9 Do not include missing mass correction 

10 Do not use friction in dynamic analysis 

11 Y – Vertical 

CAEPIPE Hanger Report  
Node Spring 

Rate 
Hot 
Load 

1015 19.287 2430 

Refer Appendix D for details 

Total Weight (Kg) 
CAEPIPE 4227.4 

CAESAR II 4233.3 

Support Load (Sustained) 
 Node Fx (lb) Fy (lb) Fz (lb) Mx (ft-lb) My (ft-lb) Mz (ft-lb) 

CAEPIPE 10 -190 -3359 -228 -1084 251 -1710 

CAESAR II 10 -191 -3360 -228 -1085 251 -1711 

        
CAEPIPE 70 195 -2666 382 -5424 -1465 2928 

CAESAR II 70 195 -2667 382 -5426 -1466 2929 

        
CAEPIPE 1040 -5 -141 -154 -5204 -690 1620 

CAESAR II 1040 -5 -142 -154 -5195 -690 1617 
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Operating Case 
 Node Fx (lb) Fy (lb) Fz (lb) Mx (ft-lb) My (ft-lb) Mz (ft-lb) 

CAEPIPE 10 -2857 -3129 -1168 -1342 845 -1394 

CAESAR II 10 -2857 -3130 -1168 -1342 845 -1395 

        
CAEPIPE 70 -734 -3285 2262 7387 -4196 9926 

CAESAR II 70 -735 -3286 2262 7388 -4197 9932 

        
CAEPIPE 1040 3592 248 -1094 -8649 23598 599 

CAESAR II 1040 3591 247 -1094 -8641 23597 595 

Frequencies (in Hz)  
Mode Number CAEPIPE CAESAR II 

1 4.857 4.9 

2 7.941 7.935 

3 9.659 9.684 

4 10.692 10.801 

5 14.637 14.611 
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About Model-019 

This model shown below is the same as Model-018 above with the following modifications. 

a. Two flanges on both sides of the valve with weight 495.32 kg each and 

b. Hanger removed from node 1015. 

  

 

Name of the Model Model – 019 

Analysis Options in CAEPIPE 
1 Code – B 31.3 (2016) 

2 Do not Include axial Force in Stress Calculations 

3 Do not use liberal allowable stress 

4 Reference Temperature = 20
0
c 

5 Number of Thermal Cycles = 7000 

6 Use pd/4t 

7 Do not include bourdon effect 

8 Do not use pressure correction for bends 

9 Do not include missing mass correction 

10 Do not use friction in dynamic analysis 

11 Y – Vertical 

Total Weight (Kg)  
CAEPIPE 5218.1 

CAESAR II 5224* 

* Refer Appendix E for details 

Support Load (Sustained) 
 Node Fx (lb) Fy (lb) Fz (lb) Mx (ft-lb) My (ft-lb) Mz (ft-lb) 

CAEPIPE 10 84 -3693 -345 -2016 489 -2990 

CAESAR II 10 84 -3694 -345 -2017 489 -2991 

        
CAEPIPE 70 -522 -6410 1077 -10081 -141 3431 

CAESAR II 70 -523 -6411 1078 -10086 -139 3431 

        
CAEPIPE 1040 438 -3605 -732 18951 1415 5452 

CAESAR II 1040 439 -3606 -733 18962 1418 5457 
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Operating Case 
 Node Fx (lb) Fy (lb) Fz (lb) Mx (ft-lb) My (ft-lb) Mz (ft-lb) 

CAEPIPE 10 -2583 -3464 -1285 -2273 1083 -2674 

CAESAR II 10 -2582 -3464 -1285 -2274 1083 -2675 

        
CAEPIPE 70 -1452 -7029 2959 2729 -2871 10429 

CAESAR II 70 -1453 -7030 2958 2728 -2870 10434 

        
CAEPIPE 1040 4035 -3216 -1672 15506 25703 4432 

CAESAR II 1040 4035 -3217 -1673 15516 25705 4435 

Frequencies (in Hz)  
Mode Number CAEPIPE CAESAR II 

1 4.403 4.396 

2 6.978 6.971 

3 8.342 8.331 

4 9.626 9.65 

5 13.51 13.492 
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About Model-020 

This model shown below is the same as Model-019 above with the following modification. 

a.   Limit stop at node 1015 without friction coefficient. 

 

  
 

Name of the Model Model – 020 

Analysis Options in CAEPIPE 
1 Code – B 31.3 (2016) 

2 Do not Include axial Force in Stress Calculations 

3 Do not use liberal allowable stress 

4 Reference Temperature = 20
0
c 

5 Number of Thermal Cycles = 7000 

6 Use pd/4t 

7 Do not include bourdon effect 

8 Do not use pressure correction for bends 

9 Do not include missing mass correction 

10 Do not use friction in dynamic analysis 

11 Y – Vertical 

Total Weight (Kg)  
CAEPIPE 5218.1 

CAESAR II 5224.0* 

* Refer Appendix E for details 

Support Load (Sustained) 
 Node Fx (lb) Fy (lb) Fz (lb) Mx (ft-lb) My (ft-lb) Mz (ft-lb) 

CAEPIPE 10 -208 -3515 -260 -1178 288 -1902 

CAESAR II 10 -208 -3516 -260 -1178 288 -1902 

        
CAEPIPE 70 203 -3077 447 -6222 -1619 3310 

CAESAR II 70 203 -3079 447 -6225 -1619 3311 

        
CAEPIPE 1040 5 -15 -187 -6591 -727 1932 

CAESAR II 1040 5 -16 -187 -6580 -727 1928 
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Operating Case 
 Node Fx (lb) Fy (lb) Fz (lb) Mx (ft-lb) My (ft-lb) Mz (ft-lb) 

CAEPIPE 10 -2797 -3333 -1223 -1660 936 -1878 

CAESAR II 10 -2796 -3334 -1223 -1660 936 -1878 

        
CAEPIPE 70 -921 -4591 2496 5552 -3952 10341 

CAESAR II 70 -922 -4592 2497 5553 -3953 10347 

        
CAEPIPE 1040 3718 -591 -1273 -3174 24137 1857 

CAESAR II 1040 3718 -591 -1274 -3168 24136 1854 

Frequencies (in Hz)  
Mode Number CAEPIPE CAESAR II 

1 5.39 5.393 

2 7.127 7.131 

3 8.532 8.531 

4 13.488 13.484 

5 17.186 17.168 
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About Model-021 

This model shown below is the same as Model-020 above with the following modification. 

a. User hanger at node 1015 with spring rate = 19.287 kg/mm and hot load = 2430 and 

b. Flexible limit stop with stiffness=1000kg/mm in vertical direction at node 40 and without friction 

coefficient. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Name of the Model Model – 021 

Analysis Options in CAEPIPE 
1 Code – B 31.3 (2016) 

2 Do not Include axial Force in Stress Calculations 

3 Do not use liberal allowable stress 

4 Reference Temperature = 20
0
c 

5 Number of Thermal Cycles = 7000 

6 Use pd/4t 

7 Do not include bourdon effect 

8 Do not use pressure correction for bends 

9 Do not include missing mass correction 

10 Do not use friction in dynamic analysis 

11 Y – Vertical 

CAEPIPE Hanger Report  
Node Spring 

Rate 
Hot 
Load 

1015 19.287 2430* 

Total Weight (Kg) 
CAEPIPE 4227.4 

CAESAR II 4233.4* 

* Refer Appendix D & E for details 

Support Load (Sustained) 
 Node Fx (lb) Fy (lb) Fz (lb) Mx (ft-lb) My (ft-lb) Mz (ft-lb) 

CAEPIPE 10 -166 -1847 -76 78 54 -215 

CAESAR II 10 -166 -1848 -76 78 54 -215 

        
CAEPIPE 70 290 -2017 -10 -1297 -1060 1252 

CAESAR II 70 290 -2018 -10 -1298 -1061 1253 
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CAEPIPE 1040 -124 641 86 -8397 -907 -757 

CAESAR II 1040 -124 640 86 -8394 -908 -762 

Operating Case 
 Node Fx (lb) Fy (lb) Fz (lb) Mx (ft-lb) My (ft-lb) Mz (ft-lb) 

CAEPIPE 10 -2837 -1907 -1045 -402 685 -185 

CAESAR II 10 -2837 -1907 -1045 -401 685 -185 

        
CAEPIPE 70 -658 -2760 1945 10723 -3868 8571 

CAESAR II 70 -658 -2761 1945 10726 -3870 8577 

        
CAEPIPE 1040 3495 880 -900 -11230 23423 -1323 

CAESAR II 1040 3495 879 -900 -11228 23421 -1328 

Frequencies (in Hz)  
Mode Number CAEPIPE CAESAR II 

1 7.553 7.545 

2 9.567 9.547 

3 10.498 10.470 

4 14.236 14.223 

5 14.637 14.611 
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About Model-022a 

This model shown below is the same as Model-021 above with the following modifications. 

a. Hanger replaces user hanger at node 1015. 

b. Flexible  limit  stop  with  stiffness=1000  kg/mm  at  node  40  in  vertical  direction  with  friction 

coefficient 0.35. 

  

Name of the Model Model – 022a 

Analysis Options in CAEPIPE 
1 Code – B 31.3 (2016) 

2 Do not Include axial Force in Stress Calculations 

3 Do not use liberal allowable stress 

4 Reference Temperature = 20
0
c 

5 Number of Thermal Cycles = 7000 

6 Use pd/4t 

7 Do not include bourdon effect 

8 Do not use pressure correction for bends 

9 Do not include missing mass correction 

10 Do not use friction in dynamic analysis 

11 Y – Vertical 

CAEPIPE Hanger Report  
Node Spring 

Rate 
Hot 
Load 

1015 10.715 1191* 

Total Weight (Kg) 
CAEPIPE 4227.4 

CAESAR II 4233.4* 

* Refer Appendix D & E for details 

Support Load (Sustained) 
 Node Fx (lb) Fy (lb) Fz (lb) Mx (ft-lb) My (ft-lb) Mz (ft-lb) 

CAEPIPE 10 0 -1526 109 47 -7 -236 

CAESAR II 10 -6 -1526 104 47 -4 -236 

        
CAEPIPE 70 131 -3208 576 1680 -386 88 

CAESAR II 70 128 -3207 563 1574 -385 115 
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CAEPIPE 1040 -14 -532 25 571 -99 -53 

CAESAR II 1040 -14 -533 22 575 -103 -54 

Operating Case 
 Node Fx (lb) Fy (lb) Fz (lb) Mx (ft-lb) My (ft-lb) Mz (ft-lb) 

CAEPIPE 10 -3329 -1589 -798 -435 601 -205 

CAESAR II 10 -3299 -1589 -809 -434 606 -205 

        
CAEPIPE 70 -844 -3970 2629 14439 -3013 7612 

CAESAR II 70 -848 -3967 2605 14252 -3023 7642 

        
CAEPIPE 1040 3544 -287 -969 -2306 23798 -627 

CAESAR II 1040 3548 -288 -973 -2299 23816 -628 

Frequencies (in Hz)  
Mode Number CAEPIPE CAESAR II 

1 7.553 7.545 

2 9.567 9.547 

3 10.498 10.470 

4 14.236 14.223 

5 14.637 14.611 
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About Model-023a 

This model shown below is the same as Model-022a above with the following modification. 

a.   Flexible limit stop in +Z direction with stiffness 1000 kg/mm without friction coefficient at node 50. 
 

 
Name of the Model Model – 023a 

Analysis Options in CAEPIPE 
1 Code – B 31.3 (2016) 

2 Do not Include axial Force in Stress Calculations 

3 Do not use liberal allowable stress 

4 Reference Temperature = 20
0
c 

5 Number of Thermal Cycles = 7000 

6 Use pd/4t 

7 Do not include bourdon effect 

8 Do not use pressure correction for bends 

9 Do not include missing mass correction 

10 Do not use friction in dynamic analysis 

11 Y – Vertical 

CAEPIPE Hanger Report  
Node Spring 

Rate 
Hot 
Load 

1015 10.715 1178* 

Total Weight (Kg) 
CAEPIPE 4227.4 

CAESAR II 4233.4* 

* Refer Appendix D & E for details 

Support Load (Sustained) 
 Node Fx (lb) Fy (lb) Fz (lb) Mx (ft-lb) My (ft-lb) Mz (ft-lb) 

CAEPIPE 10 -70 -1521 -6 50 24 -237 

CAESAR II 10 -69 -1521 -8 50 24 -236 

        
CAEPIPE 70 90 -3202 475 894 -349 389 

CAESAR II 70 90 -3203 477 912 -348 391 

        
CAEPIPE 1040 -20 -543 4 655 -198 -41 

CAESAR II 1040 -21 -544 5 660 -202 -42 



52 
 

 

Operating Case 
 Node Fx (lb) Fy (lb) Fz (lb) Mx (ft-lb) My (ft-lb) Mz (ft-lb) 

CAEPIPE 10 -2915 -1626 -520 -509 260 -182 

CAESAR II 10 -2906 -1627 -545 -509 264 -182 

        
CAEPIPE 70 -448 -4389 4899 31572 -2947 4365 

CAESAR II 70 -453 -4392 4908 31638 -2942 4402 

        
CAEPIPE 1040 3363 -280 -505 -2358 23653 -749 

CAESAR II 1040 3358 -280 -502 -2357 23627 -751 

Frequencies (in Hz)  
Mode Number CAEPIPE CAESAR II 

1 9.563 9.543 

2 10.374 10.346 

3 12.406 12.369 

4 14.262 14.246 

5 14.761 14.758 
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About Model-025 

This model shown below is the same as Model-023a above with the following modifications. 

a. Rigid limit stops without friction coefficient replaces flexible limit stops at node 40 and 50. 

b. Short radius bend at node 1040 and 

c. Vertical pipe of length 3m in Y direction 
 

 
 

Name of the Model Model – 025 

Analysis Options in CAEPIPE 
1 Code – B 31.3 (2016) 

2 Do not Include axial Force in Stress Calculations 

3 Do not use liberal allowable stress 

4 Reference Temperature = 20
0
c 

5 Number of Thermal Cycles = 7000 

6 Use pd/4t 

7 Do not include bourdon effect 

8 Do not use pressure correction for bends 

9 Do not include missing mass correction 

10 Do not use friction in dynamic analysis 

11 Y – Vertical 

CAEPIPE Hanger Report  
Node Spring Rate Hot Load 

1015 8.036 1070* 

Total Weight (Kg) 
CAEPIPE 4617.8 

CAESAR II 4623.8* 

* Refer Appendix D & E for details 

Support Load (Sustained) 
 Node Fx (lb) Fy (lb) Fz (lb) Mx (ft-lb) My (ft-lb) Mz (ft-lb) 

CAEPIPE 10 -79 -1231 18 232 -2 2 

CAESAR II 10 -78 -1231 15 232 -2 2 

        
CAEPIPE 70 74 -3220 410 1386 -157 -16 

CAESAR II 70 73 -3222 412 1397 -156 -11 
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CAEPIPE 1050 5 -1358 36 163 88 -265 

CAESAR II 1050 5 -1358 36 162 88 -268 

Operating Case 
 Node Fx (lb) Fy (lb) Fz (lb) Mx (ft-lb) My (ft-lb) Mz (ft-lb) 

CAEPIPE 10 -1597 -1300 -67 -447 9 -3 

CAESAR II 10 -1585 -1301 -107 -447 15 -3 

        
CAEPIPE 70 649 -4613 6085 41021 -3314 -5397 

CAESAR II 70 639 -4615 6092 41077 -3307 -5314 

        
CAEPIPE 1050 947 -1037 -152 -413 3808 6724 

CAESAR II 1050 946 -1037 -150 -430 3803 6709 

Frequencies (in Hz)  
Mode Number CAEPIPE CAESAR II 

1 5.859 5.841 

2 9.001 8.989 

3 9.542 9.520 

4 11.467 11.447 

5 15.077 15.001 
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About Model-026 

This model shown below is the same as Model-025 above with the following modification. 

a.   Seismic coefficient of 0.3 in x direction. 
 

 
 

Name of the Model Model – 026 

Analysis Options in CAEPIPE 
1 Code – B 31.3 (2016) 

2 Do not Include axial Force in Stress Calculations 

3 Do not use liberal allowable stress 

4 Reference Temperature = 20
0
c 

5 Number of Thermal Cycles = 7000 

6 Use pd/4t 

7 Do not include bourdon effect 

8 Do not use pressure correction for bends 

9 Do not include missing mass correction 

10 Do not use friction in dynamic analysis 

11 Y – Vertical 

CAEPIPE Hanger Report  
Node Spring Rate Hot Load 

1015 8.036 1070* 

Total Weight (Kg) 
CAEPIPE 4617.8 

CAESAR II 4623.8* 

* Refer Appendix D & E for details 

Support Load (Sustained) 
 Node Fx (lb) Fy (lb) Fz (lb) Mx (ft-lb) My (ft-lb) Mz (ft-lb) 

CAEPIPE 10 -79 -1231 18 232 -2 2 

CAESAR II 10 -78 -1231 15 232 -2 2 

        
CAEPIPE 70 74 -3220 410 1386 -157 -16 

CAESAR II 70 73 -3222 412 1397 -156 -11 

        
CAEPIPE 1050 5 -1358 36 163 88 -265 

CAESAR II 1050 5 -1358 36 162 88 -268 
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Operating Case 
 Node Fx (lb) Fy (lb) Fz (lb) Mx (ft-lb) My (ft-lb) Mz (ft-lb) 

CAEPIPE 10 -1597 -1300 -67 -447 9 -3 

CAESAR II 10 -1585 -1301 -107 -447 15 -3 

        
CAEPIPE 70 649 -4613 6085 41021 -3314 -5397 

CAESAR II 70 639 -4615 6092 41076 -3307 -5314 

        
CAEPIPE 1050 947 -1037 -152 -413 3808 6724 

CAESAR II 1050 946 -1037 -150 -430 3802 6709 

Seismic Case 
 Node Fx (lb) Fy (lb) Fz (lb) Mx (ft-lb) My (ft-lb) Mz (ft-lb) 

CAEPIPE 10 1751 39 65 12 9 3 

CAESAR II 10 1751 39 65 12 9 2 

        
CAEPIPE 70 890 5 31 250 490 5780 

CAESAR II 70 890 4 29 235 490 5783 

        
CAEPIPE 1050 414 21 16 249 185 2385 

CAESAR II 1050 414 21 16 247 185 2387 

Frequencies (in Hz)  
Mode Number CAEPIPE CAESAR II 

1 5.859 5.841 

2 9.001 8.989 

3 9.542 9.520 

4 11.467 11.447 

5 15.077 15.001 
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About Model-027 

This model shown below is the same as Model-025 above with the following modification. 

a.   Wind in X direction. 

 
Name of the Model Model – 027 

Analysis Options in CAEPIPE 
1 Code – B 31.3 (2016) 

2 Do not Include axial Force in Stress Calculations 

3 Do not use liberal allowable stress 

4 Reference Temperature = 20
0
c 

5 Number of Thermal Cycles = 7000 

6 Use pd/4t 

7 Do not include bourdon effect 

8 Do not use pressure correction for bends 

9 Do not include missing mass correction 

10 Do not use friction in dynamic analysis 

11 Y – Vertical 

CAEPIPE Hanger Report  
Node Spring 

Rate 
Hot 
Load 

1015 8.036 1070* 

Total Weight (Kg) 
CAEPIPE 4617.8 

CAESAR II 4623.8 

* Refer Appendix D & E for details 

Support Load (Sustained) 
 Node Fx (lb) Fy (lb) Fz (lb) Mx (ft-lb) My (ft-lb) Mz (ft-lb) 

CAEPIPE 10 -79 -1231 18 232 -2 2 

CAESAR II 10 -78 -1231 15 232 -2 2 

        
CAEPIPE 70 74 -3220 410 1386 -157 -16 

CAESAR II 70 73 -3222 412 1397 -156 -11 

        
CAEPIPE 1050 5 -1358 36 163 88 -265 

CAESAR II 1050 5 -1358 36 162 88 -268 
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Operating Case 
 Node Fx (lb) Fy (lb) Fz (lb) Mx (ft-lb) My (ft-lb) Mz (ft-lb) 

CAEPIPE 10 -1597 -1300 -67 -447 9 -3 

CAESAR II 10 -1585 -1301 -107 -447 15 -3 

        
CAEPIPE 70 649 -4613 6085 41021 -3314 -5397 

CAESAR II 70 639 -4615 6092 41077 -3307 -5314 

        
CAEPIPE 1050 947 -1037 -152 -413 3808 6724 

CAESAR II 1050 946 -1037 -150 -430 3803 6709 

Wind Case 
 Node Fx (lb) Fy (lb) Fz (lb) Mx (ft-lb) My (ft-lb) Mz (ft-lb) 

CAEPIPE 10 2268 122 291 -29 -38 8 

CAESAR II 10 2301 119 298 -29 -40 8 

        
CAEPIPE 70 3051 22 -142 -1140 -96 -17089 

CAESAR II 70 3203 22 -138 -1106 -274 -18756 

        
CAEPIPE 1050 2256 -22 -27 400 -694 11875 

CAESAR II 1050 2331 -15 -91 911 -358 12803 

Frequencies (in Hz)  
Mode Number CAEPIPE CAESAR II 

1 5.859 5.841 

2 9.001 8.989 

3 9.542 9.520 

4 11.467 11.447 

5 15.077 15.001 
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About Model-050 

This model shown below is the same as Model-019 above with the following modification. 

a.   Seismic in both x and z directions. 

 

  

 
Name of the Model Model – 050 

Analysis Options in CAEPIPE 
1 Code – B 31.3 (2016) 

2 Do not Include axial Force in Stress Calculations 

3 Do not use liberal allowable stress 

4 Reference Temperature = 20
0
c 

5 Number of Thermal Cycles = 7000 

6 Use pd/4t 

7 Do not include bourdon effect 

8 Do not use pressure correction for bends 

9 Do not include missing mass correction 

10 Do not use friction in dynamic analysis 

11 Y – Vertical 

Total Weight (Kg)  
CAEPIPE 5218.1 

CAESAR II 5224* 

* Refer Appendix E for details 

Support Load (Sustained) 
 Node Fx (lb) Fy (lb) Fz (lb) Mx (ft-lb) My (ft-lb) Mz (ft-lb) 

CAEPIPE 10 91 -3310 -260 -1706 377 -2419 

CAESAR II 10 91 -3310 -260 -1702 376 -2412 

        
CAEPIPE 70 -454 -4976 849 -7741 47 2514 

CAESAR II 70 -454 -4977 850 -7749 47 2516 

        
CAEPIPE 1040 363 -3218 -589 17134 1248 4319 

CAESAR II 1040 364 -3219 -590 17144 1251 4324 
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Operating Case 
 Node Fx (lb) Fy (lb) Fz (lb) Mx (ft-lb) My (ft-lb) Mz (ft-lb) 

CAEPIPE 10 -2576 -3080 -1200 -1963 971 -2103 

CAESAR II 10 -2575 -3080 -1200 -1964 971 -2104 

        
CAEPIPE 70 -1383 -5595 2729 5069 -2684 9513 

CAESAR II 70 -1384 -5596 2730 5069 -2683 9517 

        
CAEPIPE 1040 3960 -2829 -1529 13689 25536 3298 

CAESAR II 1040 3960 -2829 -1530 13697 25538 3301 

Seismic Case 
 Node Fx (lb) Fy (lb) Fz (lb) Mx (ft-lb) My (ft-lb) Mz (ft-lb) 

CAEPIPE 10 1918 122 778 65 284 161 

CAESAR II 10 1918 122 779 65 284 161 

        
CAEPIPE 70 949 214 1743 12599 607 6226 

CAESAR II 70 949 214 1744 12603 607 6227 

        
CAEPIPE 1040 652 112 944 655 3521 323 

CAESAR II 1040 652 112 944 655 3522 323 

Frequencies (in Hz)  
Mode Number CAEPIPE CAESAR II 

1 4.403 4.396 

2 6.978 6.971 

3 8.342 8.331 

4 9.626 9.605 

5 13.51 13.492 
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7.3 Live Project Models 

To test the functionality of the Translator, 7 live analysis models with more complexity was chosen 
and transferred electronically using the Translator. Then the missing items/information were added 
manually to the transferred CAESAR II model. The analyses were then performed and the results 
between CAEPIPE and CAESAR II were compared and found identical. The results are tabulated below 
for all the models. 

Note: 

The models chosen for testing and comparing the results are included with the distribution CD for 
reference. Due to space constraints in listing the results for all nodes, the table listed below shows values 

for Total weight, Support loads under different loading conditions and frequencies. 

During the verification, the “Hot Load” and the “Spring Rate” obtained from the hanger results report of 
CAEPIPE were entered manually at the “Cold Load” and “Spring Rate” fields of CAESAR II hanger input 
to get identical results between CAEPIPE and CAESAR II. Hence we recommend you to input the above 

said parameters manually to CAESAR II before performing the analysis, if you recreate the “.cii” file using 
the Translator for your testing. We also recommend you to add the missing items/information reported 
in the log file to the CAESAR II binary model before performing the analysis. 
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About 7522029_D105_rev14a_ friction 

This model is a carbon steel (A53 Grade B) insulated 150 lb class piping system connected to a Dryer 

Overhead Receiver and operating at 41
0 

C in a Oil Refinery Expansion Project. The model has line sizes 
of nominal diameter 2”, 3” and 4” and comprises of straight pipes, elbows, tees, reducers and WN 

flanges. The system is of welded constructions and has 2 limit stops and 1 lateral restraint. Cases 

considered for analysis are sustained, operating and seismic. Cut-off frequency is 33 Hz. Piping code 

used is ASME B31.3. 
 

 
 

Name of the Model 7522029_D105_rev14a_ friction.mod 

Analysis Options in CAEPIPE 
1 Code – B 31.3 (2016) 

2 Do not Include axial Force in Stress Calculations 

3 Do not use liberal allowable stress 

4 Use pd/4t 

5 Do not include bourdon effect 

6 Do not use pressure correction for bends 

7 Include missing mass correction 

8 Do not use friction in dynamic analysis 

9 Include hanger stiffness 

Total Weight (Kg)  
CAEPIPE 309.65 

CAESAR II 309.30 

Support Load (Sustained) 
 Node Fx (lb) Fy (lb) Fz (lb) Mx (ft-lb) My (ft-lb) Mz (ft-lb) 

CAEPIPE 10 -1 -129 1 1 0 3 

CAESAR II 10 -1 -129 1 1 0 3 

        
CAEPIPE 140 1 -84 -1 50 5 21 

CAESAR II 140 1 -84 -1 50 5 21 
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CAEPIPE 250 9 -57 -7 6 13 1 

CAESAR II 250 9 -58 -8 6 13 1 
 

Operating Case 
 Node Fx (lb) Fy (lb) Fz (lb) Mx (ft-lb) My (ft-lb) Mz (ft-lb) 

CAEPIPE 10 63 361 -232 -623 -94 -246 

CAESAR II 10 60 355 -230 -615 -96 -243 

        
CAEPIPE 140 133 -609 -169 958 267 -142 

CAESAR II 140 131 -602 -167 948 265 -140 

        
CAEPIPE 250 -294 1131 323 340 -652 2121 

CAESAR II 250 -287 1151 323 344 -661 2178 

Seismic Case 
 Node Fx (lb) Fy (lb) Fz (lb) Mx (ft-lb) My (ft-lb) Mz (ft-lb) 

CAEPIPE 10 38 6 33 4 5 5 

CAESAR II 10 38 6 34 4 5 5 

        
CAEPIPE 140 44 61 58 113 181 334 

CAESAR II 140 44 61 58 113 181 334 

        
CAEPIPE 250 49 18 18 4 33 52 

CAESAR II 250 49 18 18 4 34 54 

Frequencies (in Hz)  
Mode Number CAEPIPE CAESAR II 

1 1.991 1.993 

2 3.662 3.665 

3 6.041 6.051 

4 8.686 8.688 
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About 7513306_D157_rev13a_friction 

This model is a 6” and 8” nominal diameter carbon steel (A53 Grade B) 300 lb class insulated piping 
system connected to Residue MP steam generators in a Oil Refinery Expansion Project. Operating 

temperature is 232
0 

C. The model consists of straight pipes, elbows, reducers, tees and flanges. The 
system is of  welded construction and has 18 limit stops, 10 lateral restraints and 2 valves. Cases 

considered for analysis are sustained, operating and seismic. Cut-off frequency is 33 Hz. Friction at 
supports is considered in the dynamic analysis. Piping code used is ASME B31.3. 
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Name of the Model 7513306_D157_rev13a_friction.mod  

Analysis Options in CAEPIPE 
1 Code – B 31.3 (2016) 

2 Do not Include axial Force in Stress Calculations 

3 Do not use liberal allowable stress 

4 Use pd/4t 

5 Do not include bourdon effect 

6 Do not use pressure correction for bends 

7 Include missing mass correction 

8 Do not use friction in dynamic analysis 

9 Include hanger stiffness 

Total Weight (Kg)  
CAEPIPE 5495.2 

CAESAR II 5495.2 

Support Load (Sustained)  

 Node Fx (lb) Fy (lb) Fz (lb) Mx (ft-lb) My (ft-lb) Mz (ft-lb) 

CAEPIPE 10 0 -397 565 144 31 -67 

CAESAR II 10 1 -396 574 151 31 -71 

        
CAEPIPE 90 -47 -429 -635 -158 -75 -37 

CAESAR II 90 -48 -432 -646 -165 -76 -40 

Operating Case 
 Node Fx (Kg) Fy (Kg) Fz (Kg) Mx (Kg-m) My (Kg-m) Mz (Kg-m) 

CAEPIPE 10 -151 -509 400 -13 41 109 

CAESAR II 10 -148 -503 141 -76 39.9 107.7 

        
CAEPIPE 90 25 99 76 11 9 75 

CAESAR II 90 23 93 324 73.8 8.9 74.2 

Seismic Case 
 Node Fx (Kg) Fy (Kg) Fz (Kg) Mx (Kg-m) My (Kg-m) Mz (Kg-m) 

CAEPIPE 10 14 103 41 10 35 141 

CAESAR II 10 14 104 41 10.6 35.3 141.5 

        
CAEPIPE 90 89 144 120 4 59 124 

CAESAR II 90 89 145 122 3.5 58.7 125.4 

Frequencies (in Hz)  
Mode Number CAEPIPE CAESAR II 

1 1.423 1.444 

2 1.631 1.633 

3 1.745 1.775 

4 2.160 2.160 
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About 522002_d221-rev323_fg_02_ope_friction_r01 

This model is a 12” nominal diameter insulated carbon steel (A53 Grade B), 150 lb class suction piping to 

Gas oil Product Pumps in an Oil Refinery Expansion Project. Operating temperature is 120
0 

C. The model 
consists of straight pipes, elbows, tees and flanges. There are valves, limit stops and lateral restraints. 

The system is of welded construction. Cases considered for analyses are sustained, operating and 

seismic. Cut-off frequency is 33 Hz; friction at supports is considered in dynamic analysis. Piping code 

used is ASME B31.3 
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Name of the Model 7522002_d221-rev323_fg_02_ope_friction_r01.mod 

Analysis Options in CAEPIPE 
1 Code – B 31.3 (2016) 

2 Do not Include axial Force in Stress Calculations 

3 Do not use liberal allowable stress 

4 Reference Temperature = 20
0
c 

5 Number of Thermal Cycles = 7000 

6 Use pd/4t 

7 Do not include bourdon effect 

8 Do not use pressure correction for bends 

9 Include missing mass correction 

10 Do not use friction in dynamic analysis 

11 Include hanger stiffness 

12 Y – Vertical 

Total Weight (Kg)  
CAEPIPE 6327.9 

CAESAR II 6316.4 

Support Load (Sustained) 
 Node Fx (lb) Fy (lb) Fz (lb) Mx (ft-lb) My (ft-lb) Mz (ft-lb) 

CAEPIPE 10 59 -285 -1 146 119 -63 

CAESAR II 10 59 -283 -1 141 118 -62 

        
CAEPIPE 160 44 -1140 107 661 -1381 -1825 

CAESAR II 160 44 -1141 108 664 -1389 -1842 

        
CAEPIPE 400 -60 -288 -3 150 -123 78 

CAESAR II 400 -60 -286 -3 145 -123 77 

Operating Case 
 Node Fx (lb) Fy (lb) Fz (lb) Mx (ft-lb) My (ft-lb) Mz (ft-lb) 

CAEPIPE 10 616 -3573 -411 8270 487 -2995 

CAESAR II 10 614 -3479 -410 7888 478 -2960 

        
CAEPIPE 160 -896 -616 733 -2193 -5914 -1098 

CAESAR II 160 -902 -612 741 -2218 -5979 -1095 

        
CAEPIPE 400 -279 -3642 -422 8289 -171 1269 

CAESAR II 400 -280 -3532 -427 7946 -180 1261 

Seismic Case 
 Node Fx (lb) Fy (lb) Fz (lb) Mx (ft-lb) My (ft-lb) Mz (ft-lb) 

CAEPIPE 10 1033 1844 938 2603 2836 2845 

CAESAR II 10 1033 1795 938 2833 2833 2822 

        
CAEPIPE 160 285 58 314 281 1099 462 

CAESAR II 160 285 59 315 281 1101 462 

        
CAEPIPE 400 1027 1730 915 2425 2869 2803 

CAESAR II 400 1027 1687 915 2296 2865 2780 

Frequencies (in Hz)  
Mode Number CAEPIPE CAESAR II 

1 3.592 3.597 

2 7.161 7.165 

3 8.369 8.364 
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About 7521020_d54_rev13a_ with frictionfg 

This model is a carbon steel (A53 Grade B), 150 lb class insulated piping system connected to a Dryer 
and operating at 120

0 
C in an Oil Refinery Expansion Project. The model has line sizes of nominal 

diameter 4”, 6”, 8”, 10”, 16” and 24” and comprises of straight pipes, elbows, reducers, tees and welding 

neck flanges. There are concentrated masses such as valves. The system is of welded construction and 

has 2 spring hangers, 4 limit stops and 2 lateral restraints. Cases considered for analysis are sustained, 
operating, seismic and wind. Cut-off frequency is 33Hz. Friction at support is considered in dynamic 

analysis. Piping code used is ASME B31.3. 

 

 
 

Name of the Model 7521020_d54_rev13a_ with frictionfg.mod 
Analysis Options in CAEPIPE 
1 Code – B 31.3 (2016) 

2 Do not Include axial Force in Stress Calculations 

3 Do not use liberal allowable stress 

4 Use pd/4t 

5 Do not include bourdon effect 

6 Do not use pressure correction for bends 

7 Include missing mass correction 

8 Do not use friction in dynamic analysis 

9 Include hanger stiffness 

 

Node 
CAEPIPE  

Spring Rate (kg/mm) Hot Load (kg) 
94 13.593 586 

1020B 54.384 3246 

Refer Appendix D for details 
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Total Weight (Kg)  
CAEPIPE 7606.7 

CAESAR II 7643.8 

Support Load (Sustained) 
 Node Fx (Kg) Fy (Kg) Fz (Kg) Mx (Kg-m) My (Kg-m) Mz (Kg-m) 

CAEPIPE 10 -15 -910 -46 -2121 77 816 

CAESAR II 10 -10 -911 -47 -2128 82.2 818.3 

        
CAEPIPE 170 2 -422 -6 -7 2 -13 

CAESAR II 170 2 -423 -6 -7.8 1.9 -12.9 

        
CAEPIPE 1290 -11 -277 0 49 -3 -22 

CAESAR II 1290 -11 -277 0 48.9 -2.6 -22.4 

Operating Case 
 Node Fx (Kg) Fy (Kg) Fz (Kg) Mx (Kg-m) My (Kg-m) Mz (Kg-m) 

CAEPIPE 10 -35 -1167 32 -2431 82 -360 

CAESAR II 10 -26 -1169 16 -2397 87.1 -359.2 

        
CAEPIPE 170 25 -473 -60 -115 30 -98 

CAESAR II 170 24 -472 -59 -113.4 29.10 -96.2 

        
CAEPIPE 1290 -471 697 -295 233 -249 -1140 

CAESAR II 1290 -441 642 -249 112.4 -230 -1068.2 

Seismic Case 
 Node Fx (Kg) Fy (Kg) Fz (Kg) Mx (Kg-m) My (Kg-m) Mz (Kg-m) 

CAEPIPE 10 1356 192 522 559 23 542 

CAESAR II 10 1357 192 523 570.9 26.9 541.4 

        
CAEPIPE 170 110 19 128 245 26 207 

CAESAR II 170 110 19 128 244.3 26.1 206.3 

        
CAEPIPE 1290 360 16 102 214 133 1151 

CAESAR II 1290 360 16 102 213.2 133.2 1152.0 

Frequencies (in Hz)  
Mode Number CAEPIPE CAESAR II 

1 2.342 2.334 

2 2.574 2.567 

3 2.750 2.77 

4 3.194 3.18 

5 3.463 3.79 
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About 7509002_D69_R12a_with_friction 

This model is a 8” nominal diameter carbon steel (A106 Grade B) insulated 150 lb class piping system 
between LP Amine Absorber and LP Amine Absorber KO Drum in a Oil Refinery Expansion Project. 

Operating temperature is 135
0 

C. The model consists of straight pipes and elbows. The piping system is 
of welded construction with 12 limit stops and 3 lateral restraints.  Cases considered are sustained, 

operating and seismic. Cut-off frequency is 33Hz. Friction at supports is considered in dynamic analysis. 
Piping code used is ASME B31.3. 
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Name of the Model 7509002_D69_R12a_with_friction.mod 

Analysis Options in CAEPIPE 
1 Code – B 31.3 (2016) 

2 Do not Include axial Force in Stress Calculations  
3 Do not use liberal allowable stress 

4 Use pd/4t 

5 Do not include bourdon effect 

6 Do not use pressure correction for bends 

7 Include missing mass correction 

8 Do not use friction in dynamic analysis 

9 Include hanger stiffness 

10 Y Vertical 

Total Weight (Kg)  
CAEPIPE 4463.5 

CAESAR II 4465.8 

Support Load (Sustained) 
 Node Fx (Kg) Fy (Kg) Fz (Kg) Mx (Kg-m) My (Kg-m) Mz (Kg-m) 

CAEPIPE 5 7 -238 -11 -195 -1 -15 

CAESAR II 5 7 -241 -11 -197.9 -1.2 -16.8 

        
CAEPIPE 290 6 -163 17 9 -2 -4 

CAESAR II 290 6 -163 17 8.1 -2.1 -3.5 

Operating Case 
 Node Fx (Kg) Fy (Kg) Fz (Kg) Mx (Kg-m) My (Kg-m) Mz (Kg-m) 

CAEPIPE 5 -226 -270 146 -150 -134 -100 

CAESAR II 5 -227 -274 149 -156.2 -134.2 -101.1 

        
CAEPIPE 290 111 -235 343 267 -50 -39 

CAESAR II 290 110 -235 333 257.8 -49.6 -40.2 

Seismic Case 
 Node Fx (Kg) Fy (Kg) Fz (Kg) Mx (Kg-m) My (Kg-m) Mz (Kg-m) 

CAEPIPE 5 207 32 97 30 127 44 

CAESAR II 5 207 32 97 30 127.4 44.5 

        
CAEPIPE 290 30 3 203 227 6 94 

CAESAR II 290 30 3 203 227.6 5.9 93.7 

Frequencies (in Hz)  
Mode Number CAEPIPE CAESAR II 

1 2.297 2.294 

2 3.283 3.279 

3 4.043 4.041 

4 5.258 5.256 

5 5.294 5.284 
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About 7510004_D72_rev6a_fg_des_with_friction 

This model is a 2”, 4”, 8” and 12” nominal diameter carbon steel (A106 Grade B) 150 lb class insulated 
piping system connected between MHC stripper Air condenser and MHC stripper Trim condenser in a Oil 

Refinery Expansion Project. Operating temperature of the system is 55
0 

C. The model comprises of 
straight pipes, elbows, tees and flanges. The system is of welded construction and has 8 limit stops, 1 

lateral restraint and 8 valves. Cases considered for analysis are sustained, operating and seismic. Cut-off 
frequency is 33Hz. Piping code used is ASME B31.3. 

 

 
 
 

Name of the Model 7510004_D72_rev6a_fg_des_with_friction.mod 

Analysis Options in CAEPIPE 
1 Code – B 31.3 (2016) 

2 Do not Include axial Force in Stress Calculations 

3 Do not use liberal allowable stress 

4 Use pd/4t 

5 Do not include bourdon effect 

6 Do not use pressure correction for bends 

7 Include missing mass correction 

8 Do not use friction in dynamic analysis 

9 Include hanger stiffness 

Total Weight (Kg)  
CAEPIPE 6905 

CAESAR II 6908 
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Support Load (Sustained) 
 Node Fx (Kg) Fy (Kg) Fz (Kg) Mx (Kg-m) My (Kg-m) Mz (Kg-m) 

CAEPIPE 10 46 -322 14 73 -62 67 

CAESAR II 10 39 -322 6 70.1 -63.3 68.4 

        
CAEPIPE 1070 -101 -24 -2 -1 1 -16 

CAESAR II 1070 -99 -24 -2 -0.5 1.1 -15.9 

        
CAEPIPE 2300 -32 -78 30 -9 -2 -19 

CAESAR II 2300 -33 -79 30 -8.8 -2.1 -19.50 

Operating Case 
 Node Fx (Kg) Fy (Kg) Fz (Kg) Mx (Kg-m) My (Kg-m) Mz (Kg-m) 

CAEPIPE 10 330 -460 1183 423 517 120 

CAESAR II 10 325 -458 1166 417.9 506.4 119.8 

        
CAEPIPE 1070 595 128 -401 120 10 222 

CAESAR II 1070 601 122 -397 117.7 10.8 222.1 

        
CAEPIPE 2300 89 -268 292 -36 -106 -68 

CAESAR II 2300 87 -269 299 -35.9 -107.9 -68.3 

Seismic Case 
 Node Fx (Kg) Fy (Kg) Fz (Kg) Mx (Kg-m) My (Kg-m) Mz (Kg-m) 

CAEPIPE 10 390 25 746 359 1347 73 

CAESAR II 10 390 25 747 359.2 1347.3 72.6 

        
CAEPIPE 1070 36 56 104 13 28 95 

CAESAR II 1070 35 56 104 12.9 28.2 95 

        
CAEPIPE 2300 29 24 213 2 63 6 

CAESAR II 2300 29 25 214 1.9 63 5.7 

Frequencies (in Hz)  
Mode Number CAEPIPE CAESAR II 

1 2.311 2.308 

2 4.451 4.461 

3 5.315 5.311 

4 7.396 7.762 

5 8.775 8.762 
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About 7510016_D77_rev32_fg_op..r01 

This model is a 10” nominal dia carbon steel (A53 Grade B) 300 lb class piping between MHC stripper 
Bottom Pumps and Atmospheric Distillation Feed Bottom Exchanger ina Oil Refinery Expansion Project. 
The model conists of straight pipes, elbows, tees and flanges. There are limit stops, lateral restraints and 

concentrated masses such as valves. The system is of welded construction.  Cases considered for 
analysis are sustained, operating, and seismic. Cut-off frequency is 33 Hz. Piping code used is ASME 

B31.3. 
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Name of the Model 7510016_D77_rev32_fg_op..r01.mod  

Analysis Options in CAEPIPE 
1 Code – B 31.3 (2016) 

2 Do not Include axial Force in Stress Calculations 

3 Do not use liberal allowable stress 

4 Use pd/4t 

5 Do not include bourdon effect 

6 Do not use pressure correction for bends 

7 Include missing mass correction 

8 Do not use friction in dynamic analysis 

9 Include hanger stiffness 

Node Spring Rate 

(kg/mm) 
Hot Load (kg)  

280 8.0361 1058 

Refer Appendix D for details  
Total Weight (Kg) 
CAEPIPE 11569 

CAESAR II 11574.3 

Support Load (Sustained) 
 Node Fx (Kg) Fy (Kg) Fz (Kg) Mx (Kg-m) My (Kg-m) Mz (Kg-m) 

CAEPIPE 10 -33 -797 41 10 20 -538 

CAESAR II 10 -33 -797 42 10.3 20.3 -538.9 

        
CAEPIPE 480 -17 -150 -53 -27 15 0 

CAESAR II 480 -16 -150 -57 -29 16.9 0.2 

        
CAEPIPE 630 -28 -151 -52 -26 11 6 

CAESAR II 630 -27 -152 -56 -27.9 13.6 6.3 

Operating Case 
 Node Fx (Kg) Fy (Kg) Fz (Kg) Mx (Kg-m) My (Kg-m) Mz (Kg-m) 

CAEPIPE 10 -177 -1024 451 422 713 -401 

CAESAR II 10 -170 -1025 458 432.5 700.7 -413.9 

        
CAEPIPE 480 -483 -27 102 -36 29 311 

CAESAR II 480 -479 -45 106 -25.3 29.9 304.8 

        
CAEPIPE 630 -407 624 -105 -416 -31 168 

CAESAR II 630 -373 585 -61 -382.9 -33.4 141.4 

Seismic Case 
 Node Fx (Kg) Fy (Kg) Fz (Kg) Mx (Kg-m) My (Kg-m) Mz (Kg-m) 

CAEPIPE 10 263 4 421 937 386 372 

CAESAR II 10 263 4 421 939 386.3 373.2 

        
CAEPIPE 480 221 652 605 309 256 102 

CAESAR II 480 226 650 604 309.5 256.7 100.2 

        
CAEPIPE 630 245 212 694 310 290 180 

CAESAR II 630 233 217 697 311 293.2 177.2 
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Frequencies (in Hz) 
Mode Number CAEPIPE CAESAR II 

1 1.658 1.661 

2 2.784 2.785 

3 2.977 2.982 

4 3.429 3.442 

5 3.65 3.644 
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Appendix A 

Material Mapping DB 

The Material Mapping DB supplied along with the software is used to map the CAEPIPE Material to the 

CAESAR II Materials. This Mapping DB basically has two tables viz, Material and CII_Material. The table 

“Material” is used to map the CAEPIPE Material with the CAESAR II Materials. To enable the effective 
transfer of material information from CAEPIPE, the description used in CAEPIPE Material Input is taken 

as a key value and is entered in the field 1 “CAEPIPEMat” of table “Material” and the corresponding 
material number in CAESAR II is then entered into the field 2 “CAESARMat” of table “Material” by 
referring the CAESAR II documentation. 

Secondly, the table “CII_Material” is used to define the default CII material to be used during the transfer. 
The Translator collects all the CAESAR II materials listed in this table and displays them in a combo box, 
if the user selects the “Default CII Hanger and Material” from the “Option” menu. User is then allowed 
to specify the default CII material through this option. If the material corresponding to CAEPIPE 
material description is not available in the material mapping DB, then the Translator uses this information 
to transfer it to CAESAR II. 

Hanger Mapping DB 

The Hanger Mapping DB supplied along with the software is used to map the CAEPIPE Hanger with the 

CAESAR II Hanger. This Mapping DB basically has two tables viz, Hanger and CII_Hangers. The table 

“Hanger” is used to map the CAEPIPE Hanger with the CAESAR II Hanger. To enable the effective 

transfer of hanger information from CAEPIPE, the internal reference number used in CAEPIPE is taken 

as a key value and is entered in the field 1 (KP_Hanger) of table “Hanger” and the corresponding hanger 
number in CAESAR II is then entered into the field 2 (CII_Hanger) of table “Hanger” by referring the 
CAESAR II documentation. 

Secondly, the table “CII_Hangers” is used to define the default CII hanger to be used during the transfer. 
The Translator collects all the CAESAR II hangers listed in this table and displays them in a combo box, 
if the user selects the “Default CII Hanger and Material” from the “Option” menu. User is then allowed 
to specify the default CII hanger through this option. If the hanger corresponding to CAEPIPE hanger is 
not available in the hanger mapping DB, then the Translator uses this information to transfer it to CAESAR 
II. 
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Appendix B 

Errors and Descriptions 

This Appendix presents the list of errors, their descriptions and the necessary actions to be taken. 

a.  “Enter all the Necessary Data and Proceed” 

User has to enter the neutral file name, model batch file name and has to select hanger type from the 

hanger list. 

b. “Not a valid CAEPIPE mod file” 

The CAEPIPE model file selected is not a valid .mod file. 

c. "Could not find a part of the path <path>” 

Appears, If the user enters the wrong path and file name in the “CAESAR II File” text box. 
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Appendix C 

Units Mapping 

This sections lists, how the CAEPIPE units are transferred to CAESAR II. 
 

Sl.No. CAEPIPE Units CAESAR II Units 
1. Length Length 

2. Force Force 

3. Weight Force 

4. Moment Moment Input 

5. Moment Moment Output 

6. Stress Stress 

7. Temperature Temperature 

8. Pressure Pressure 

9. Modulus Elastic Modulus 

10. Density Pipe Density 

11. Insulation Density Insulation Density 

12. Density Fluid Density 

13. Stiffness Translational Stiffness 

14. Rotational Stiffness Rotational Stiffness 

15. Additional Weight Uniform Load 

16. G’s G Load 

17. Pressure Wind Load 

18. Dimension Elevation 

19. Dimension Compound Length 

20. Dimension Diameter 

21. Dimension Thickness 
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Appendix D 
Hanger 

This section lists, how to model the Hanger manually in CAESAR II corresponding to CAEPIPE Hanger 
report results. 

To get good comparison between CAEPIPE and CAESAR II results, the “Hot Load” and “Spring Rate” 
obtained from hanger report of CAEPIPE analysis results are entered manually at the hanger location of 
CAESAR II at the “Operating Load” and “Spring Rate” of hanger input in CAESAR II. 

The procedure for entering the “Hot Load” and “Spring Rate” from CAEPIPE Hanger report to CAESAR II 

is given below. 

1. Perform the Analysis in CAEPIPE and note down the “Hot Load” and “Spring Rate” from the 

Hanger Report for each hanger location. 

2. Convert the CAEPIPE model file (.mod) to CAESAR II format (.cii) electronically using the KP2CII 
Translator. 

3. Convert the batch input (.cii) file into binary file (._A) through CAESAR II->Tools->External 
Translator. Tools->External Interfaces->CAESAR II Neutral File” as shown in the left figure below. 

4. From the figure shown in the right below, select the radio button “Convert Neutral File to CAESAR 
II Input File” and then press the button “Browse” and select the “.cii” file. 

 

 

5. Upon  successful  conversion,  the  user  will  get  a  message  “The  conversion  was completed 

successfully”. 

6. Now, open the binary file (._A) through “File->Open”. 

7. From the “Input” menu, select piping as shown in the figure below. 
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8. Navigate to the element where the hanger is placed and then enter the CAEPIPE-reported “Hot 
Load” and the “Spring Rate” at the marked fields in figure shown below. 
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Appendix E 
Reducer Weight Calculation 

During the Verification and Validation of the Translator, we observed a few kg differences in the 
total weight of the system between CAEPIPE and CAESAR II models. Further study in this regard 
concluded that the difference in weight between CAEPIPE and CAESAR II is only due to the presence of 
Reducer in the piping system. 

To verify the above said statement, the weight of the Reducer element was calculated manually as 

specified in the CAEPIPE and CAESAR II Technical Reference manual. The difference in the weight 
results between CAEPIPE and CAESAR II was minor in the hand calculations. But, the difference was 

significant between the results compared by KP and C-II. 

To verify further, two piping systems were modeled in both CAEPIPE and CAESAR II with the following 

specifications. 

Model-1: Reducer_Larger_to_Smaller 

The first system was modeled with larger diameter pipe at the beginning and the smaller diameter pipe at 
the end with a reducer of larger diameter at the left end and smaller diameter at the right end placed in 

between two horizontal pipes. The model shown in figure below has the following. 

1. Two pipe element of lengths 2m each. 

2. Reducer Element of 500 mm length in between the two pipes. 

3. The outside diameter and the wall thickness of the first pipe are 273.05 mm and 15.062 mm 

respectively. 

4. The OD1 and Thickness1 of the reducer element are 273.05 and 15.062 mm and OD2 and 
Thickness2 of the reducer element is 219.05 mm and 12.7 mm respectively. 

5. The outside diameter and the wall  thickness of  the second  pipe are 219.05 and  12.7 mm 

respectively and 

6. The density of the material is 7833 kg/m3 and the density of the fluid is entered as 0 kg/m3. 

 

 
  



83 
 

Model-2: Reducer_Smaller_to_Larger 

On the other hand, the second system was modeled with smaller diameter pipe at the beginning and the 

larger diameter pipe at the end with a reducer of smaller diameter at the left end and larger diameter at 
the right end placed in between the two horizontal pipes. The model shown in figure below has the 

following. 

1. Two pipe element of lengths 2m each. 

2. Reducer Element of 500 mm length in between the two pipes. 

3. The outside diameter and the wall thickness of the first pipe are 219.05 mm and 12.7 mm 
respectively. 

4. The OD1 and Thickness1  of  the reducer element are 219.05 and  12.7 mm  and OD2 and 

Thickness2 of the reducer element is 273.05 mm and 15.062 mm respectively. 

5. The outside diameter and the wall thickness of the second pipe are 273.05 and 15.062 mm 

respectively and 

6. The density of the material is 7833 kg/m3 and the density of the fluid is entered as 0 kg/m3. 

 

 

The analyses were then performed in both CAEPIPE and CAESAR II for both models and total weight 
obtained in both the software for each model was then compared with the hand calculation and observed 

the following. CAESAR II calculates the reducer weight as the weight of a pipe with its OD and Thickness 

as OD1 and Thk1 of the reducer. This is contrary to the statement given in Chapter 3 “Piping Screen 
Reference” of Technical Reference Manual of CAESAR II which states “CAESAR II will construct a 
concentric reducer element made of ten pipe cylinders, each of a successively larger (or smaller) 
diameter and wall thickness over the element length”. Hence you may experience in increase/decrease in 

total weight of the system between CAEPIPE and CAESAR II depending upon the number of reducer 
element the system has. 
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The details of observation are listed below for reference. 
 

CAEPIPE 

Reducer_Larger_to_Smaller.mod 

 
Element 

 
Length (mm) 

OD/Avg. OD 

(mm) 
Thk/Avg.Tk 

(mm) 
Density 

(kg/m3) 
Hand Calculated 

Weight (Kg) 
Weight from 

Analysis Report 
Pipe1 2000 273.05 15.062 7833 191.245024  

Reducer 500 246.06 13.881 7833 39.6544284  

Pipe2 2000 219.05 12.7 7833 128.978164  

     359.877616 359.91 (kg) 

CAESAR II - 4.50 

Reducer_Larger_to_Smaller.mod 

 

Element 
 

Length (mm) 
 

OD (mm) 
 

Thk (mm) 
Density 

(kg/m3) 
Hand Calculated 

Weight (Kg) 
Weight from 

Analysis Report 

Pipe1 2000 273.05 15.062 7833 191.245024  

Reducer 500 273.05 15.062 7833 47.811256  

Pipe2 2000 219.05 12.7 7833 128.978164  

     368.034443 368.04 (kg) 

       

CAEPIPE 

Reducer_Smaller_to_Larger.mod 

 

Element 
 

Length (mm) 
OD/Avg. OD 

(mm) 
Thk/Avg.Tk 

(mm) 
Density 

(kg/m3) 
Hand Calculated 

Weight (Kg) 
Weight from 

Analysis Report 
Pipe1 2000 219.05 12.7 7833 128.978164  

Reducer 500 246.06 13.881 7833 39.6544284  

Pipe2 2000 273.05 15.062 7833 191.245024  

     359.877616 359.91 (kg) 

CAESAR II - 4.50 

Reducer_Smaller_to_Larger.mod 

 

Element 
 

Length (mm) 
OD/Avg. OD 

(mm) 
Thk/Avg.Tk 

(mm) 
Density 

(kg/m3) 
Hand Calculated 

Weight (Kg) 
Weight from 

Analysis Report 
Pipe1 2000 219.05 12.7 7833 128.978164  

Reducer 500 219.05 12.7 7833 32.2445409  

Pipe2 2000 273.05 15.062 7833 191.245024  

     352.467728 352.5 (kng) 

The above tabulated comparison results for CAESAR II between the hand calculation and the results 
computed by CAESAR II software clearly shows that the CAESAR II uses the OD1 and Thk1 for weight 
calculation. 

Note: The models chosen for testing and comparing the results are included with the distribution inside 
the folder “Reducer_Verification” for reference. 


